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IntroductionIntroductionIntroductionIntroduction    
The Type Lite is a note taker and personal digital 
assistant with built-in speech synthesizer, 40 cell 
Braille display, a laptop PC style keyboard and built 
in applications such as date book, phone book, and 
calculator. This product can go anywhere to act as a 
note taker, it is easily linked to a full computer, it has 
a Datebook to remind you of appointments and much 
more. Use it to create documents, organize your 
schedule, maintain contacts, and transfer information 
to and from your PC. 

This users guide is organized into the following 
sections: 

• Getting Started contains introductory 
information, and all you need to know to quickly 
get up and running with your Type Lite. 

• Using the Type Lite contains detailed 
information on the main features of the Type 
Lite, including the Type Lite Editor and utilities. 

• Advanced Features contains information on the 
most advanced functions of the Type Lite, 
including macros and connecting the Type Lite 
to other devices. 

• The appendices contain reference information to 
provide you quick access to essential 
information. 
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OverviewOverviewOverviewOverview    
The Type Lite uses a portable (Laptop) PC style, 
Windows keyboard. The Type Lite provides speech 
output through an internal synthesizer, and Braille 
output through a 40 cell refreshable Braille display. 
The Type Lite has 2 megabytes of RAM (Random 
Access Memory), 12 megabytes of read only flash 
memory, and accepts standard compact flash™ 
memory cards.  

The Type Lite KeyboardThe Type Lite KeyboardThe Type Lite KeyboardThe Type Lite Keyboard    
The Type Lite uses a standard portable PC style 
keyboard. The top row consists of an ESCESCESCESC key on the 
left, followed by F1 F1 F1 F1 through F12F12F12F12, and then NUM NUM NUM NUM 
LOCKLOCKLOCKLOCK, INSERTINSERTINSERTINSERT, DELETEDELETEDELETEDELETE, and BREAKBREAKBREAKBREAK. There is a raised 
locater dot above F1F1F1F1, F5F5F5F5, F10F10F10F10, and DELETEDELETEDELETEDELETE. 

The bottom row, from left to right, consists of Fn Fn Fn Fn 
(Function key)(Function key)(Function key)(Function key), CTRLCTRLCTRLCTRL, Windows logo keyWindows logo keyWindows logo keyWindows logo key, ALTALTALTALT, 
SPACEBARSPACEBARSPACEBARSPACEBAR, ALTALTALTALT, Windows logo keyWindows logo keyWindows logo keyWindows logo key, Application keyApplication keyApplication keyApplication key, 
CTRLCTRLCTRLCTRL, LEFT ARROWLEFT ARROWLEFT ARROWLEFT ARROW, DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW, and RIGHT RIGHT RIGHT RIGHT 
ARROWARROWARROWARROW. The UP ARRUP ARRUP ARRUP ARROW OW OW OW key is directly above the 
DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW key. 

The Type Lite BrailleThe Type Lite BrailleThe Type Lite BrailleThe Type Lite Braille Display Display Display Display    
The Type Lite has a forty-cell Braille display below 
the keyboard. There are two advance bars between 
the display and the keyboard, and rockers on either 
side of the Braille display. There are cursor routing 
buttons above each cell, and raised locator dots 
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above cells five, ten, fifteen, twenty, twenty-five, 
thirty, and thirty-five. 

PortsPortsPortsPorts and Switches and Switches and Switches and Switches    
The back of the Type Lite, from left to right, has an 
AC/Adapter jack, the compact flash module (add-on 
memory), disk drive port, serial port, PC keyboard 
port, external keyboard port, and parallel port.  

The headphone jack is on the right edge of the 
system, between the On/Off switch and the back of 
the system. 

The Type Lite MenusThe Type Lite MenusThe Type Lite MenusThe Type Lite Menus    
The Type Lite has several menus that allow you to 
access commands and configuration settings. 

File (F1)File (F1)File (F1)File (F1)    

Allows you to organize and work with files. 

Disk Drive SDisk Drive SDisk Drive SDisk Drive Storage (SHIFT+F8)torage (SHIFT+F8)torage (SHIFT+F8)torage (SHIFT+F8)    

Allows you to transfer files to an external disk drive. 

Options (F9 or ALT+O)Options (F9 or ALT+O)Options (F9 or ALT+O)Options (F9 or ALT+O)    

Allows you to Allows you to Allows you to Allows you to access built in applications. 

StatusStatusStatusStatus (F10 or ALT+SLASH)F10 or ALT+SLASH)F10 or ALT+SLASH)F10 or ALT+SLASH)    

Allows you to configure Type Lite settings. 

As in other menus, simply use arrow keys to locate 
the menu item you want. Press SPACEBARSPACEBARSPACEBARSPACEBAR to toggle 
settings. Press ALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROW to hear the 
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access key to move directly to the current item. In 
the Status Menu, use FN+UP ARROWFN+UP ARROWFN+UP ARROWFN+UP ARROW or FN+DOWN FN+DOWN FN+DOWN FN+DOWN 
ARROWARROWARROWARROW to move through the sections of the menu. 

Speech Parameters (F7 or ALT+SHIFT+PERIOD)Speech Parameters (F7 or ALT+SHIFT+PERIOD)Speech Parameters (F7 or ALT+SHIFT+PERIOD)Speech Parameters (F7 or ALT+SHIFT+PERIOD)    

The Speech Parameters Menu is slightly different 
because each parameter is accessed with a different 
key. More information is available in the Configuring 
Speech Parameters section of this guide. 

ConventionsConventionsConventionsConventions    
This manual specifies keyboard commands in the 
following manner.  

• Keys to be pressed are in all capital letters and 
bold.  

• When keys are to be pressed simultaneously, 
this is indicated by joining the keys with a PLUS 
(+) sign.  

• When keys are to be pressed one after the 
other, this is indicated by separating the keys 
with a COMMA (,). 

For example, "Press F10F10F10F10, ALT+SALT+SALT+SALT+S, SPACEBARSPACEBARSPACEBARSPACEBAR to toggle 
speech on or off." 

Getting HelpGetting HelpGetting HelpGetting Help    
The Type Lite provides several methods for getting 
help. Press BREAKBREAKBREAKBREAK to open the Type Lite help file.  

Press SHIFT+BREAK SHIFT+BREAK SHIFT+BREAK SHIFT+BREAK to enter Key Learn Mode. Key 
Learn mode allows you to explore the functionality of 
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the Type Lite keyboard. While in Key Learn mode, the 
first time you press a key, the name of the key is 
spoken and/or displayed. If the key has a specific 
function (such as the function keys and other 
extended keys), the second time you press the key, 
its function is spoken and/or displayed. 
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Working with FilesWorking with FilesWorking with FilesWorking with Files    
The Type Lite provides a full range of features for 
working with files. You can create, edit, rename, 
move, and delete files. 

Opening FilesOpening FilesOpening FilesOpening Files    
There are several ways to open a file:  

• Press F1F1F1F1, then use the DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW key and 
the UP ARROWUP ARROWUP ARROWUP ARROW key to locate the file. Press 
ENTENTENTENTERERERER once the file is located.  

• Press F9F9F9F9, then the number associated with the 
file. This number will range from 00 to 99.  

• To open the previously opened file, press F9F9F9F9, LLLL. 

Creating FilesCreating FilesCreating FilesCreating Files    
To create a file, press F1F1F1F1, C C C C and type in the file name. 
Then press ENTERENTERENTERENTER. The file name cannot exceed 
twenty characters. 

RenamingRenamingRenamingRenaming and Deleting and Deleting and Deleting and Deleting Files Files Files Files    
To rename a file, press F1F1F1F1, move to the file, and 
press ALT+RALT+RALT+RALT+R. Type in the new file name and press 
ENTERENTERENTERENTER. 

To delete a file, press F1F1F1F1, locate the file, and press 
DELETEDELETEDELETEDELETE. Press Y Y Y Y to confirm or N N N N to cancel. 
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ReadingReadingReadingReading Files Files Files Files    
Files can be read by character, word, line, or in their 
entirety. Following are commonly used reading 
commands. 

To read by character: 

Next character RIGHT ARROWRIGHT ARROWRIGHT ARROWRIGHT ARROW 
Previous character LEFT ARROWLEFT ARROWLEFT ARROWLEFT ARROW 
Current character ALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROW 
Current character 
phonetically ALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROW, twice 
 quickly 

To read by word: 

Next word CTRL+RIGHT ARROWCTRL+RIGHT ARROWCTRL+RIGHT ARROWCTRL+RIGHT ARROW 
Previous word CTRL+LEFT ARROWCTRL+LEFT ARROWCTRL+LEFT ARROWCTRL+LEFT ARROW 
Current word CTRL+DOCTRL+DOCTRL+DOCTRL+DOWN ARROWWN ARROWWN ARROWWN ARROW 
Spell current word CTRL+DOWN ARROWCTRL+DOWN ARROWCTRL+DOWN ARROWCTRL+DOWN ARROW, twice  

To read by line: 

Next line DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW 
Previous line UP ARROWUP ARROWUP ARROWUP ARROW 
Current line CTRL+UP ARROWCTRL+UP ARROWCTRL+UP ARROWCTRL+UP ARROW 

To move quickly through a file: 

Move to next paragraph FN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROW 
Move to prior paragraph FN+UP ARROWFN+UP ARROWFN+UP ARROWFN+UP ARROW 
Beginning of file FN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROW 
End of file FN+RIGHT ARROWFN+RIGHT ARROWFN+RIGHT ARROWFN+RIGHT ARROW 
Read from current cursor 
to the end of the file SHIFT+DOWN ARROWSHIFT+DOWN ARROWSHIFT+DOWN ARROWSHIFT+DOWN ARROW 
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Silence Speech  CTRL+ALTCTRL+ALTCTRL+ALTCTRL+ALT 

EditingEditingEditingEditing Files Files Files Files    
The Type Lite calls the default editing mode, Append 
mode. Anything you type is added to the end of the 
open file, even if you are reading at the beginning of 
the file. This is a great way to quickly take notes!  

To insert text at the cursor location within the file, 
press INSERTINSERTINSERTINSERT, type in the text, and press INSERTINSERTINSERTINSERT 
again. 

To overwrite one character at the cursor location, 
press SHIFT+INSERTSHIFT+INSERTSHIFT+INSERTSHIFT+INSERT. To continuously overwrite text 
from the cursor location, press SHIFT+INSERTSHIFT+INSERTSHIFT+INSERTSHIFT+INSERT twice, 
type in the new text, and press SHIFT+INSERTSHIFT+INSERTSHIFT+INSERTSHIFT+INSERT again. 

To delete the character at the cursor location, press 
DELETEDELETEDELETEDELETE twice. To delete multiple characters, press 
DELETEDELETEDELETEDELETE, CCCC, the number of characters to delete (up to 
255), and then press ENTER ENTER ENTER ENTER to move the deleted 
text to the clipboard, replacing any text already in 
the clipboard. Press NUM LOCKNUM LOCKNUM LOCKNUM LOCK Instead of ENTERENTERENTERENTER to 
append the deleted text to that already in the 
clipboard. 

This same process can be applied to words, 
sentences, and paragraphs. For example, DELETEDELETEDELETEDELETE, 
W5W5W5W5, ENTER ENTER ENTER ENTER deletes five words from the cursor 
location forward, and places that text on the 
clipboard. DELETEDELETEDELETEDELETE, P3P3P3P3, NUM LOCK NUM LOCK NUM LOCK NUM LOCK deletes three 
paragraphs and appends the deleted text to that 
already on the clipboard. 
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Text can also be copied or appended to the clipboard 
without deleting it.  

1. Move the cursor to the beginning of the text and 
press ALT+MALT+MALT+MALT+M to mark the location.  

2. Move the cursor to the end of the text and press 
SHIFT+NUM LOCKSHIFT+NUM LOCKSHIFT+NUM LOCKSHIFT+NUM LOCK.  

3. Press CCCC to copy the text to the clipboard, or AAAA to 
append the text to that already in the clipboard. 

To paste information at the cursor location, press 
NUM LOCKNUM LOCKNUM LOCKNUM LOCK. You are prompted to specify what 
information to paste. Press CCCC to paste the clipboard 
contents, DDDD to paste the date, or TTTT to paste the time.  

To find text within a file, press F2F2F2F2, type in the text, 
and press F2F2F2F2 again. 
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Customizing the Type LiteCustomizing the Type LiteCustomizing the Type LiteCustomizing the Type Lite    
Many features within the Type Lite can be custom 
configured. This section discusses customizing 
Speech parameters, Braille display parameters, and 
editing parameters. 

CustomizingCustomizingCustomizingCustomizing Speech Speech Speech Speech Parameter Parameter Parameter Parameterssss    
To access the speech parameters, press F7F7F7F7 or 
ALT+SHIFT+PERIODALT+SHIFT+PERIODALT+SHIFT+PERIODALT+SHIFT+PERIOD. The following options can be 
adjusted while in Speech Parameters. Press ESCESCESCESC after 
making changes to exit Speech parameters. 

You can choose between eight voices. Press 
CTRL+LEFT ARROWCTRL+LEFT ARROWCTRL+LEFT ARROWCTRL+LEFT ARROW or CTRL+RIGHT ARROWCTRL+RIGHT ARROWCTRL+RIGHT ARROWCTRL+RIGHT ARROW to cycle 
through them. The voices are: Perfect Paul, Vader, 
Big Bob, Precise Pete, Ricochet Randy, Biff, Skip, and 
Robo Robert.  

To adjust volume, press the UPUPUPUP or DOWN ARROW DOWN ARROW DOWN ARROW DOWN ARROW 
keys. To adjust the rate of speech, press the LEFTLEFTLEFTLEFT or 
RIGHT ARROW RIGHT ARROW RIGHT ARROW RIGHT ARROW keys.  

Press NNNN to toggle the Type Lite between reading 
numbers as full numbers or as a series of single 
digits. For example, 121 can be read as "one 
hundred twenty one" or "one two one."  

Press SPACEBARSPACEBARSPACEBARSPACEBAR to set the Type Lite to echo 
keyboard activity: 
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• Word Echo Word Echo Word Echo Word Echo - Typed words are echoed after 
pressing SPACEBARSPACEBARSPACEBARSPACEBAR, a punctuation mark, or 
ENTERENTERENTERENTER. 

• Key Echo Key Echo Key Echo Key Echo - Typing Keys are spoken as they are 
pressed. 

• Key ClickKey ClickKey ClickKey Click - Typing keys click as they are pressed. 

• Silent KeysSilent KeysSilent KeysSilent Keys - There is no auditory indication 
when keys are pressed. 

To specify the amount of punctuation spoken, press ZZZZ 
for none, SSSS for Some, MMMM for most, or TTTT for total. 

Speech can be turned off from the Status menu. To 
toggle speech on or off, press F10F10F10F10, ALT+SALT+SALT+SALT+S, 
SPACEBARSPACEBARSPACEBARSPACEBAR, ESCESCESCESC. 

ConfiguConfiguConfiguConfiguringringringring Braille Braille Braille Braille Parameters Parameters Parameters Parameters    
The Type Lite can display information in Grade Two or 
in Computer Braille. To toggle display of text in files 
between Grade Two and Computer Braille, press F10F10F10F10, 
ALT+7ALT+7ALT+7ALT+7, SPACEBARSPACEBARSPACEBARSPACEBAR. To toggle display of system 
messages and menus between Grade Two and 
Computer Braille, press F10F10F10F10, ALT+GALT+GALT+GALT+G, SPACEBARSPACEBARSPACEBARSPACEBAR. 

To display control characters such as carriage 
returns, press F10F10F10F10, ALT+XALT+XALT+XALT+X, YYYY. To wrap lines to less 
than 40 characters, press F10F10F10F10, ALT+WALT+WALT+WALT+W, YYYY. 

ConfiguringConfiguringConfiguringConfiguring Editing Editing Editing Editing Parameters Parameters Parameters Parameters    
The Type Lite defaults to Append mode, however, it 
can also be set to function in the same manner as a 
word processing application on a computer. To set 
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this PC Edit mode, press F10F10F10F10, SHIFT+4SHIFT+4SHIFT+4SHIFT+4, IIII. Once you 
set this option, the Type Lite defaults to Insert mode 
when it starts. While in Insert mode, press INSERTINSERTINSERTINSERT 
from within any RAM file to toggle between Append, 
Overwrite, and Insert modes. 

By default, the Type Lite does not display the 
presence of blank lines. To have the Type Lite show 
blank lines, press F10F10F10F10, SHIFT+7SHIFT+7SHIFT+7SHIFT+7, NNNN. 
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The Type Lite UtilitiesThe Type Lite UtilitiesThe Type Lite UtilitiesThe Type Lite Utilities    
The Type Lite includes a Clock, Calendar, Datebook, 
Phonebook, and Calculator. 

TimeTimeTimeTime and Date and Date and Date and Date    
To check the time, press F4F4F4F4. To set the time, press 
F9F9F9F9, SSSS, TTTT and enter the time in the format hhmm. You 
are prompted to enter AAAA for a.m. or PPPP for p.m., if you 
are using American, 12-hour time. The time takes 
effect immediately if you are using European, 24-
hour time. 

To use American 12-hour time format, press F9F9F9F9, SSSS, 1111. 
To use European 24-hour time format, press F9F9F9F9, SSSS, 2222. 

To check the date, press F5F5F5F5. To set the date, press 
F9F9F9F9, SSSS, D D D D and type in the date in the format 
mmddyyyy, and press ENTERENTERENTERENTER. 

The DatebookThe DatebookThe DatebookThe Datebook    
To enter an appointment into the Datebook, press F9F9F9F9, 
E E E E and type the date of the appointment in 
MMDDYYYY format. Press ENTER ENTER ENTER ENTER and type in the 
appointment information. Then press ENTER ENTER ENTER ENTER again. 

Press F9F9F9F9, AAAA to check the current day's appointments. 

To set automatic appointment notification, press 
F10F10F10F10, JJJJ, YYYY. Press ESCESCESCESC to leave the Status menu. 
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The Phone BookThe Phone BookThe Phone BookThe Phone Book    
To add an entry to the Phone Book, press F9F9F9F9, PPPP. Each 
field name is announced. Type in the information for 
each field and press ENTERENTERENTERENTER to move to the next field. 
Press ENTERENTERENTERENTER in a comment field when finished. 

To open the Phone Book, press F9F9F9F9, AAAALT+PLT+PLT+PLT+P. Press 
FN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROW or FN+UP ARROWFN+UP ARROWFN+UP ARROWFN+UP ARROW to move 
through the Phone Book by entry. The name for each 
entry is indicated. Once the desired entry is found, 
press the DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW or UP ARROWUP ARROWUP ARROWUP ARROW keys to move 
through the information. 

The CalculatorThe CalculatorThe CalculatorThe Calculator    
The Type Lite calculator is very robust with both 
standard and scientific functions. To open the 
Calculator, press F3F3F3F3. To exit the Calculator, press ESCESCESCESC. 

Standard operations are entered in the form A+B, 
with no spaces between the values and the 
operators. Press ENTERENTERENTERENTER to calculate the expression. 
The standard operators are: 

+ = plus 

- = minus 

* = times 

/ = divide 

% = percent 

F1 = square root 
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Press CTRL+UP ARROW CTRL+UP ARROW CTRL+UP ARROW CTRL+UP ARROW to hear the information 
currently displayed in the Calculator. Press F3F3F3F3 to 
clear the Calculator. 

The Calculator has 26 memory locations, represented 
by the letters A through Z. R is reserved for the result 
of the most recent calculation. To store a value to 
memory, press F4F4F4F4, followed by the letter 
representing the memory location. To use the 
information stored in memory, simply reference the 
letter of the memory location in your expression. 

The Calculator also supports many advanced 
scientific functions. For information on using these 
functions, please refer to the Type Lite’s onboard 
help.  
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Note TakingNote TakingNote TakingNote Taking    
The Type Lite functions primarily as a note taker. It is 
designed so you can effortlessly take notes in a 
meeting or in class, or review a grocery list at the 
store. Information can be reviewed with speech or 
Braille or both, so you are able to work the way that 
is most comfortable for you. 

Most Type Lite functions related to taking and 
organizing notes involve using the File menu and the 
Editor. Manage, create, and organize files from the 
File menu, and read and edit them in the Editor.  

The CursorThe CursorThe CursorThe Cursor    
The cursor is essential in the process of reading and 
editing. It marks the current location in the text. The 
cursor moves to different parts of the document 
through use of various commands. The reading 
commands move the cursor to the specified element 
of text and read it. Many editing commands involve 
actions that effect text at the location of the cursor. 

The cursor location is represented by a blinking dot 7 
and a solid dot 8. By default, the cursor is only 
visible when you are reading by character, or when 
you use a cursor routing button to move the cursor to 
a specific cell. This provides a representation of the 
cursor when you need it, while making it easier to 
read the Braille display when you don't. 
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The cursor can, however, be set to always remain 
visible. To do this: 

1. press F10F10F10F10 to open the Status menu.  

2. Press ALT+VALT+VALT+VALT+V to move to the Cursor Always 
Visible option. 

3. Press YYYY to set this option to On. 

4. Press ESCESCESCESC to exit the Status menu. 

The EditorThe EditorThe EditorThe Editor    
If you are not in a menu, an external program, or one 
of the utilities, you are in the Type Lite Editor. The 
Type Lite Editor allows you to read, write, and edit 
files.  

FilesFilesFilesFiles    
Any time you are reading or editing text in the Type 
Lite Editor, you are in a file. Even if you open Help 
with the BREAKBREAKBREAKBREAK key, you are in a file.  

To create a file: 

1. Press F1F1F1F1 to open the File menu. 

2. Press CCCC. You are prompted for a file name.  

3. Type the file name.  

4. Press ENTERENTERENTERENTER. 

File names cannot exceed twenty characters. File 
names cannot contain the following characters: 
QUESTION MARK, ASTERISK, SLASH, BACKSLASH, 
COMMA, COLON, and PERCENT. File names should 
not begin with a PERIOD. 
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There are further considerations if your files will be 
transferred to the external disk drive or to Compact 
Flash, as these storage mediums do not support the 
longer file names. In these instances, we recommend 
you use the MS-DOS "8.3" convention and do not use 
spaces in file names. This convention limits a file to 
eight characters, a period, and three more characters. 
The three characters after the period are referred to 
as a file extension, and may determine how 
applications on a PC interact with these files. For 
example, in Microsoft Windows 9.x, files with an 
extension of .txt are opened in Notepad.  

OpeningOpeningOpeningOpening Files Files Files Files    
To open an existing file: 

1. Press F1F1F1F1 to open the File menu.  

2. Arrow through the list of files. 

3. Press ENTERENTERENTERENTER when the desired file is located. 

ReadingReadingReadingReading Text Text Text Text    
Files can be read by character, word, line, or in their 
entirety. Following are the available reading 
commands. 

To read by character: 

Next character RIGHT ARROWRIGHT ARROWRIGHT ARROWRIGHT ARROW 
Previous character LEFT ARROWLEFT ARROWLEFT ARROWLEFT ARROW 
Current character ALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROW 
Current character  

phonetically ALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROW, twice  
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Immediately after hearing a character's phonetic 
representation, LEFT ARROWLEFT ARROWLEFT ARROWLEFT ARROW moves to and provides 
phonetic representation for the previous character, 
and RIGHT ARROWRIGHT ARROWRIGHT ARROWRIGHT ARROW moves to and provides phonetic 
representation for the next character. 

To read by word: 

Next word CTRL+RIGHT ARROWCTRL+RIGHT ARROWCTRL+RIGHT ARROWCTRL+RIGHT ARROW 
Previous word CTRL+LEFT ARROWCTRL+LEFT ARROWCTRL+LEFT ARROWCTRL+LEFT ARROW 
Current word CTRL+DOWN ARROWCTRL+DOWN ARROWCTRL+DOWN ARROWCTRL+DOWN ARROW 
Spell current word CTRL+DOWN ARROWCTRL+DOWN ARROWCTRL+DOWN ARROWCTRL+DOWN ARROW, twice  

Immediately after spelling a word, CTRL+LEFT CTRL+LEFT CTRL+LEFT CTRL+LEFT 
ARROWARROWARROWARROW moves to and spells the previous word, and 
CTRL+RIGHT ARROWCTRL+RIGHT ARROWCTRL+RIGHT ARROWCTRL+RIGHT ARROW moves to and spells the next 
word. 

To read by line: 

Next line DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW 
Previous line UP ARROWUP ARROWUP ARROWUP ARROW 
Current line CCCCTRL+UP ARROWTRL+UP ARROWTRL+UP ARROWTRL+UP ARROW 

To move quickly through a file: 

Move to next paragraph FN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROW 
Move to prior paragraph FN+UP ARROWFN+UP ARROWFN+UP ARROWFN+UP ARROW 
Beginning of file FN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROW 
End of file FN+RIGHT ARROWFN+RIGHT ARROWFN+RIGHT ARROWFN+RIGHT ARROW 
Read from cursor 
to the end of the file SHIFT+DOWN ARROWSHIFT+DOWN ARROWSHIFT+DOWN ARROWSHIFT+DOWN ARROW 

Silence Speech  CTRL+ACTRL+ACTRL+ACTRL+ALTLTLTLT    
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MoveMoveMoveMove    

The Move command (SHIFT+F3SHIFT+F3SHIFT+F3SHIFT+F3) lets you specify the 
parameter by which you wish to move through your 
files. After pressing SHIFT+F3SHIFT+F3SHIFT+F3SHIFT+F3, press DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW 
to move through the menu choices, or use the access 
keys listed below. 

Absolute Page (A)Absolute Page (A)Absolute Page (A)Absolute Page (A)    

After selecting this parameter, specify the number of 
absolute pages you wish to move, counted from the 
top of the file. Specify 0 to determine the total 
number of absolute pages in the file. 

Braille Page (B)Braille Page (B)Braille Page (B)Braille Page (B)    

After selecting this parameter, specify the number of 
Braille pages you wish to move, counted from the top 
of the file. Specify 0 to determine the total number 
of Braille pages in the file. 

Character (C)Character (C)Character (C)Character (C)    

After selecting this parameter, specify the number of 
characters you wish to move from the top of the file. 
Include a PLUS SIGNPLUS SIGNPLUS SIGNPLUS SIGN (++++) before the number to move 
forward the specified number of characters from the 
cursor location. Include a DASHDASHDASHDASH (----) before the 
number to move Backward the specified number of 
characters from the cursor location. Specify 0 to 
determine the total number of characters in the file. 

Line (L)Line (L)Line (L)Line (L)    
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After selecting this parameter, specify the number of 
lines you wish to move from the top of the file. 
Include a PLUS SIGNPLUS SIGNPLUS SIGNPLUS SIGN (++++) before the number to move 
forward the specified number of lines from the cursor 
location. Include a DASHDASHDASHDASH (----) before the number to 
move Backward the specified number of lines from 
the cursor location. Specify 0 to determine the total 
number of lines in the file. 

Mark (M)Mark (M)Mark (M)Mark (M)    

Use this parameter if you have previously set a mark 
(ALT+MALT+MALT+MALT+M) in your file, and wish to move back to the 
location of that mark. 

Print Page (P)Print Page (P)Print Page (P)Print Page (P)    

After selecting this parameter, specify the number of 
print pages you wish to move, counted from the top 
of the file. Specify 0 to determine the total number 
of print pages in the file. 

Word (W)Word (W)Word (W)Word (W)    

After selecting this parameter, specify the number of 
words you wish to move from the top of the file. 
Include a PLUS SIGNPLUS SIGNPLUS SIGNPLUS SIGN (++++) before the number to move 
forward the specified number of words from the 
cursor location. Include a DASHDASHDASHDASH (----) before the 
number to move Backward the specified number of 
words from the cursor location. Specify 0 to 
determine the total number of words in the file. 
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Reading With BrailleReading With BrailleReading With BrailleReading With Braille    

All reading commands discussed to this point also 
work when reading with the  

Braille display. There is also additional functionality 
when reading with Braille. The advance bars and 
rocker buttons provide easy access to commonly used 
navigation commands, and the cursor routing buttons 
provide an easy means to move the cursor directly to 
any cell. There are raised locator dots above cells 
five, ten, fifteen, twenty, twenty-five, thirty, and 
thirty-five. 

Advance BarsAdvance BarsAdvance BarsAdvance Bars    

The advance bars allow you to move through your 
files one display length at a time. Press the right end 
of either advance bar to move forward by 40 cells 
and continue reading. Press the left end of either 
advance bar to move back 40 cells to the left. In 
either case, the display wraps to the next or previous 
line of text once it reaches the end or beginning of a 
line. 

Reverse AdvanceReverse AdvanceReverse AdvanceReverse Advance    

The functionality of the advance bars can be reversed 
so the left ends of the advance bars move you right, 
and the right ends move you left. For some, this 
provides an easier reach without needing to move 
fingers that are reading the Braille display. To enable 
Reverse Advance, press F10F10F10F10, DELETEDELETEDELETEDELETE, YYYY. Press ESCESCESCESC to 
exit the Status menu. 
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RockerRockerRockerRocker Buttons Buttons Buttons Buttons    

The rocker buttons at either end of the Braille display 
are used to move line by line, sentence by sentence, 
or paragraph by paragraph. Press the FNFNFNFN key and 
either one of the rocker buttons to toggle through 
and set the choices. Each rocker can be set to a 
different navigation unit. For example, you can set 
the left rocker to move back and forward through 
your files by sentence, and set the right rocker to 
move back and forward through your files by 
paragraph. 

The middle of the rocker buttons can be set to move 
back and forward in files by word, or to move to the 
top or bottom of the file. Press FNFNFNFN and the middle of 
either rocker button to set this to prior/next word or 
to top/bottom of file. The left rocker middle is either 
prior word or top of file, and the right rocker middle 
is next word or bottom of file, regardless of which 
rocker you use to toggle this setting.  

EditingEditingEditingEditing Text Text Text Text    
The Type Lite provides a very robust environment for 
editing your files. Copy and insert text and 
information, delete characters, words, or paragraphs, 
search for and replace text, and even check spelling 
in your files. Two editing modes, Append and PC Edit, 
are also provided so you can interact with your files 
in the same way as on previous Blazie note takers, or 
in a manner similar to a word processor on a personal 
computer. 
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The editing mode is set in the Status menu. 

1. Press F10F10F10F10 to open the Status menu. 

2. Press $$$$ (SHIFT+4SHIFT+4SHIFT+4SHIFT+4) to move directly to PC 
Editing. 

3. Press SPACEBARSPACEBARSPACEBARSPACEBAR to cycle between PC Editing 
Off, PC Editing On, and PC Editing On with Insert 
at Startup. 

4. Once the desired option is selected, press ESCESCESCESC to 
exit the Status menu. 

Append ModeAppend ModeAppend ModeAppend Mode    

PC Editing is off by default, and this places you in 
Append mode. Anything you type is added to the end 
of the open file, even if you are reading at the 
beginning of the file. This is a great way to quickly 
take notes. It is, however, quite different from a word 
processing application on a PC, so it is helpful to 
remain aware of which editing mode is in use. While 
in append mode, you need to specify when you wish 
to insert or overwrite text. 

• To insert text at the cursor location within the 
file, press INSERTINSERTINSERTINSERT, type in the text, and press 
INSERTINSERTINSERTINSERT again. 

• To overwrite one character at the cursor 
location, press SHIFT+INSERTSHIFT+INSERTSHIFT+INSERTSHIFT+INSERT.  

• To continuously overwrite text from the cursor 
location, press SHIFT+INSERTSHIFT+INSERTSHIFT+INSERTSHIFT+INSERT twice, type in the 
new text, and press SHIFT+INSERTSHIFT+INSERTSHIFT+INSERTSHIFT+INSERT again. 
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PC EditPC EditPC EditPC Edit Mode Mode Mode Mode    

In PC Edit mode, the Type Lite Editor functions more 
like a word processing application on a personal 
computer. In this mode, press NUM LOCKNUM LOCKNUM LOCKNUM LOCK to toggle 
between Append, Insert, and Overwrite modes. The 
mode to which you toggle remains active until you 
change it, or until you turn your Type Lite off and 
back on again. 

• AppendAppendAppendAppend: Typed text is appended to the end of 
the file, regardless of the location of the cursor. 
When the Status menu setting previously 
mentioned is set to PC Editing On, this is the 
default mode. 

• InsertInsertInsertInsert: Typed text is inserted at the cursor 
location. If there is any text in the file beyond 
the location of the cursor, this text is pushed 
forward in the file. This mode is most similar to 
a word processer on a PC. When the Status 
menu setting mentioned above is set to PC 
Editing On with Insert at Startup, this is the 
default mode. 

• OverwritOverwritOverwritOverwriteeee: Typed text begins at the cursor 
location. If there is text beyond the location of 
the cursor, it is replaced, character for character, 
by the typed text. For example, in this mode, if 
the cursor is at the first character in the word 
"text" and you type "stuff," the word "text" is 
replaced. 
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Copying, Deleting, and PastingCopying, Deleting, and PastingCopying, Deleting, and PastingCopying, Deleting, and Pasting    
The Type Lite Editor provides full functionality for 
reorganizing text. Delete or copy text from one 
section of a file, and paste it in another section or in 
another file. Paste information from the calculator, or 
the date and time, or even paste the entire text of 
another file into your current file. 

Whether deleting or copying text, the Clipboard is 
used to temporarily store this text. This allows you to 
copy or delete text from one file, switch to another 
file, and paste the contents of the Clipboard. 
Additionally, copied or deleted text can be appended 
to that already in the Clipboard, or it can replace it. 

CopyingCopyingCopyingCopying    

There are several ways to copy text to the Clipboard. 
The following method allows you to replace any text 
already in the Clipboard, or add the copied text to 
that already in the Clipboard. 

1. Move the cursor to the beginning of the text and 
press ALT+MALT+MALT+MALT+M to mark the location.  

2. Move the cursor to the end of the text you wish 
to copy. 

3. Press SHIFT+NUM LOCKSHIFT+NUM LOCKSHIFT+NUM LOCKSHIFT+NUM LOCK.  

4. Press CCCC to copy the text to the clipboard, or AAAA to 
append the text to that already in the clipboard. 
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DeleteDeleteDeleteDelete Parameters Parameters Parameters Parameters    

When you press DELETE in any writable RAM file, the 
Delete parameters are available. These are used both 
to delete and copy information. Use the Arrow keys 
to cycle through the parameters and press ENTERENTERENTERENTER to 
select the one you wish to use. Alternately, press a 
Delete Parameter's access key to select it. 

Block (B)Block (B)Block (B)Block (B): Prompts for a string of text, and deletes 
from the cursor to the first instance of that string of 
text. Text cannot be copied with this parameter. 

Character (C)Character (C)Character (C)Character (C): Prompts for a number of characters, 
and counts them from the cursor forward through the 
file. Use this parameter to copy or delete. 

Line (L)Line (L)Line (L)Line (L): Prompts for a number of lines, and counts 
them from the cursor forward through the file. Use 
this parameter to copy or delete. 

Mark (M)Mark (M)Mark (M)Mark (M): This parameter deletes text between a 
mark set in a file and the cursor location. Press 
ALT+M to set a marALT+M to set a marALT+M to set a marALT+M to set a mark in a filek in a filek in a filek in a file. Text cannot be copied 
with this parameter. 

Paragraph (P)Paragraph (P)Paragraph (P)Paragraph (P): Prompts for a number of paragraphs, 
and counts them from the cursor forward through the 
file. Use this parameter to copy or delete. 

Sentence (S)Sentence (S)Sentence (S)Sentence (S): Prompts for a number of sentences, 
and counts them from the cursor forward through the 
file. Use this parameter to copy or delete. 
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Word (W)Word (W)Word (W)Word (W): Prompts for a number of words, and 
counts them from the cursor forward through the file. 
Use this parameter to copy or delete. 

CursorCursorCursorCursor to En to En to En to End of Text (Z)d of Text (Z)d of Text (Z)d of Text (Z): Deletes from the location 
of the cursor forward to the end of text in the file. 
This parameter cannot be used to copy text. 

When selecting the Character, Line, Paragraph, 
Sentence, or Word parameters, there is a maximum 
number of 255 units. 

After selecting the Delete parameter and any 
information for which you are prompted, press: 

ENTERENTERENTERENTER to delete the text and move it to the 
Clipboard, replacing any text already in the Clipboard. 

NUM LOCKNUM LOCKNUM LOCKNUM LOCK to delete the text and move it to the 
Clipboard, appending it to any text already in the 
Clipboard. 

SHIFT+NUM LOCKSHIFT+NUM LOCKSHIFT+NUM LOCKSHIFT+NUM LOCK to copy the text to the Clipboard 
without deleting it. Copying in this fashion replaces 
any text in the Clipboard. If the selected parameter 
does not support copying, the procedure is aborted. 

ExaExaExaExamplesmplesmplesmples    

To delete the character at the cursor location, press 
DELETEDELETEDELETEDELETE twice. To delete multiple characters, press 
DELETEDELETEDELETEDELETE, CCCC, the number of characters to delete (up to 
255), and then press ENTER ENTER ENTER ENTER to move the deleted 
text to the clipboard, replacing any text already in 
the clipboard. Press NUM LOCKNUM LOCKNUM LOCKNUM LOCK Instead of ENTERENTERENTERENTER to 
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append the deleted text to that already in the 
clipboard. 

This same process can be applied to words, 
sentences, and paragraphs.  

PastingPastingPastingPasting Information Information Information Information    

To paste information at the cursor location, press 
NUM LOCKNUM LOCKNUM LOCKNUM LOCK. You are prompted to specify what 
information to paste. Use DOWN ARROW and UP 
ARROW to cycle through the choices, or use the 
access keys listed below: 

CCCC pastes the clipboard contents 

DDDD pastes the date 

FFFF pastes contents of a file 

G pastes get date 

TTTT pastes the time  

SHIFT+3 pastes Stopwatch 

R pastes result from Calculator 

NoteNoteNoteNote: When using NUM LOCKNUM LOCKNUM LOCKNUM LOCK to paste 
information into a file, it is inserted at the 
cursor location regardless of which editing 
mode is active. 

The Tab KeyThe Tab KeyThe Tab KeyThe Tab Key    
The TABTABTABTAB key on the Type Lite works much differently 
than in a word processor on a PC. It is used to tab 
over from the left margin, or to insert a repeated 
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number of characters. After pressing TABTABTABTAB, a prompt 
is presented. You have two options: 

• Specify the number of the column to which to 
tab and press ENTERENTERENTERENTER. Columns are measured in 
characters and numbered from left to right. 

• Specify a non-numeric character, followed by the 
number of characters to insert (2 to 255), and 
press ENTERENTERENTERENTER. 

FindFindFindFind    
To find a string of text, press F2F2F2F2, type in the string of 
text, and press F2F2F2F2 again. The text string cannot 
exceed 63 characters. this searches from the cursor 
location forward to the end of the file. 

To search backwards from the cursor location in the 
file, press F2F2F2F2, type in the text to find, and press UP UP UP UP 
ARROWARROWARROWARROW. 

To find a date, press F2F2F2F2, and press ALT+GALT+GALT+GALT+G. This starts 
the Smart Calendar. Type the number of days or the 
date in MMDDYYYY format and press ENTER. 

Find and ReplaceFind and ReplaceFind and ReplaceFind and Replace    

The Type Lite also lets you find and replace strings of 
text.  

1. Press F2F2F2F2. 

2. Type in the text to find.  

3.3.3.3.    Press ALT+RALT+RALT+RALT+R.        

4. Type in the replacement text. 
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5. Press ALT+RALT+RALT+RALT+R. 

The Type Lite then searches your file. When the 
specified text is found, the following options are 
available: 

• Press RRRR to replace the currently found instance 
of text. 

• Press SSSS to skip the currently found instance of 
text. 

• Press AAAA to replace all further instances of the 
specified text. 

• Press ALT+CALT+CALT+CALT+C to hear/display the line in which 
the text was found. 

Case SensitiveCase SensitiveCase SensitiveCase Sensitive Searches Searches Searches Searches    

The Type Lite find feature is not case sensitive by 
default, but this can be enabled in the Status menu. 

1. Press F10F10F10F10 to open the Status menu. 

2. Press SHIFT+1SHIFT+1SHIFT+1SHIFT+1 to move to Distinguish Case 
During Find. 

3. Press YYYY to set this option to On. 

4. Press ESCESCESCESC to exit the Status menu. 

NoteNoteNoteNote: While case sensitive searches are 
sometimes very useful, they may seriously 
reduce the number of matches when 
performing a find operation. 
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Global searchGlobal searchGlobal searchGlobal search    
A global search is one that includes multiple files. 
There are two ways to search globally: from within a 
file, or from the File menu. 

When searching from a file, follow these steps: 

1. Press F2F2F2F2. 

2. Type the string of text for which you wish to 
search. 

3. Press ALT+FALT+FALT+FALT+F. 

4. Type in the Search Options you wish to use. 
Search Options are listed below. 

5. Press ENTERENTERENTERENTER. 

When searching from the File menu (F1F1F1F1), follow 
these steps: 

1. Press ALT+FALT+FALT+FALT+F. 

2. Type in a file mask, such as *.txt or *.brl. 

3. Press ALT+FALT+FALT+FALT+F. 

4. Type in the string of text for which you wish to 
search. 

5. Press ENTERENTERENTERENTER. 

6. Type in the Search Options you wish to use. 
Search Options are listed below. 

7. Press ENTERENTERENTERENTER. 
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Search OptionsSearch OptionsSearch OptionsSearch Options    

The following choices are available at the Search 
Options prompt: 

All Files AAAA 

RAM Files RRRR 

Flash Files FFFF 

Ram and Flash Files ZZZZ 

Files in 
Current Folder OOOO 

Braille Files BBBB 

Duxbury or 
Megadots Files DDDD 

Text Files TTTT 

Small Files 
(2 pages or less) SSSS 

Medium Size Files 
(3 to 10 pages) MMMM 

Large Files 
(over 10 pages) LLLL 

Case Sensitive CCCC 

Quiet Search QQQQ 

Currently Open File PERIODPERIODPERIODPERIOD 

List Matches 
in Clipboard NUMBER SIGNNUMBER SIGNNUMBER SIGNNUMBER SIGN 
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By default, the Type Lite searches all RAM files 
regardless of folder, searches both Braille and text 
files, and is not case sensitive. If this is exactly the 
search you want, simply press ENTER ENTER ENTER ENTER at the Search 
Options prompt. Otherwise, Type in the options you 
desire. For example, to search large text files in both 
RAM and flash, type LTZ. To search just small files in 
the current folder, type SO.  

When a match is found, the following options are 
available: 

Open File OOOO 

Continue Search CCCC 

Skip to Next File SSSS 

Speak Text in Context ALT+CALT+CALT+CALT+C 

File Name SHIFT+F1SHIFT+F1SHIFT+F1SHIFT+F1 

Abort ESCESCESCESC 

NoteNoteNoteNote: When you select Open File (OOOO), the search 
is stopped. When you select Skip to Next 
File (SSSS), the search continues from the next 
file. 

Spell CheckSpell CheckSpell CheckSpell Check    
The Type Lite provides a spell check utility to verify 
correct spelling within files. The spell check is an 
external program - it is not built into your unit like 
many other tools. The program file "spell.dic" must 
be present in order for you to work with the spell 
check. The spell check program file should already be 
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loaded on your unit. The file, "spell.dic," uses 86 
Type Lite pages. We recommend you store this file in 
Flash.  

To start the spell check, press F6F6F6F6. Press WWWW to check 
the current word, or press ZZZZ to check from the cursor 
location to the end of the file. To check an entire file, 
first move your cursor to the beginning of the file 
(FN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROW).  

The Type Lite indicates when it does not recognize a 
word, and it spells that word. Several options are 
then presented. Use the Arrow keys to cycle through 
the options and press ENTERENTERENTERENTER to select the option you 
desire. Most of these options also have access keys 
to directly select them. Press ALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROWALT+DOWN ARROW to 
hear the access key for the current option. 

Add Word to Personal Dictionary (A)Add Word to Personal Dictionary (A)Add Word to Personal Dictionary (A)Add Word to Personal Dictionary (A)    

The first time this option is used, a file named 
"Personal.dic" is created in RAM. This file stores 
words not found in the standard spell check 
dictionary. Add words the spell check does not 
recognize, though they are spelled correctly, such as 
personal names. 

Bypass Word for Rest of Document (B)Bypass Word for Rest of Document (B)Bypass Word for Rest of Document (B)Bypass Word for Rest of Document (B)    

Spell check ignores any further instances of the 
current word in the open file. 

Read Word in Context (C)Read Word in Context (C)Read Word in Context (C)Read Word in Context (C)    

Spell check reads/displays the line of text in which 
the current word is found. 
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Enter the Correct in Document (E)Enter the Correct in Document (E)Enter the Correct in Document (E)Enter the Correct in Document (E)    

Spell check prompts you to type in the word as you 
wish it to be spelled. 

Skip Word (O)Skip Word (O)Skip Word (O)Skip Word (O)    

Spell check skips the current instance of the word 
and continues checking the file. Any further instances 
of the same word are found. 

Repeat Incorrect Word (R)Repeat Incorrect Word (R)Repeat Incorrect Word (R)Repeat Incorrect Word (R)    

Spell check reads and spells the current word. 

Repeat PhoneticallyRepeat PhoneticallyRepeat PhoneticallyRepeat Phonetically    

Spell check spells the current word using phonetic 
representation. 

Suggestion Words from a List (S)Suggestion Words from a List (S)Suggestion Words from a List (S)Suggestion Words from a List (S)    

Spell check lists suggestions to use for the current 
word. Use the Arrow keys to cycle through the 
choices and ENTERENTERENTERENTER to select a word. ESCESCESCESC exits the 
list, and returns you to the previous list of options for 
the current word. 

Suggestion Words Help (Q)Suggestion Words Help (Q)Suggestion Words Help (Q)Suggestion Words Help (Q)    

Spell check indicates how to navigate within the word 
suggestion list. 

Press ESCESCESCESC to cancel a spell check operation. If you are 
in the word suggestion list, press ESCESCESCESC twice. 
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ManagingManagingManagingManaging Files Files Files Files    
The File menu, accessed with F1F1F1F1, allows you to 
manage your files. Rename, delete, write protect, or 
even password protect your files. When you first 
press F1F1F1F1, a list of files is active.  

• Use the Arrow keys to move through the list of 
files.  

• Press FN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROW to move to the top of the 
list, or FN+RIGHT ARROWFN+RIGHT ARROWFN+RIGHT ARROWFN+RIGHT ARROW to move to the bottom 
of the list.  

• Press BREAKBREAKBREAKBREAK to access the File Commands menu 
and use the Arrow keys as in the File list to 
move through the available commands.  

• Press ENTERENTERENTERENTER to open the selected file in the 
Files list, or to activate the selected command in 
the File Commands list. If more information is 
required, you are prompted for it. 

• Press ALT+DOWN ARROW ALT+DOWN ARROW ALT+DOWN ARROW ALT+DOWN ARROW on any command, and 
the access key for that command is indicated. 

MemoryMemoryMemoryMemory    
The memory structure of the Type Lite is important 
when considering how to organize your files. The 
Type Lite has two megabytes of RAM and twelve 
megabytes of Flash memory. The Type Lite also 
accepts standard Compact Flash™ modules. Files 
must be created and edited in RAM. Files cannot be 
edited in Flash, though they can be read there. Files 
can be copied from RAM to Compact Flash and back, 
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but they cannot be copied from Flash to Compact 
Flash. 

Consider RAM as the hub through which files must 
move when you wish to work with them or back them 
up to Compact Flash. As such, we recommend you do 
not create folders and store files in RAM. There is 
much more available space in Flash to use for 
creating folders and organizing your files. 

FoldersFoldersFoldersFolders    
To create and use folders to organize your files, Allow 
Folder Mode must be enabled in the Status menu. 
Press F10F10F10F10, ALT+FALT+FALT+FALT+F, YYYY to enable Allow Folder Mode, 
and press ESCESCESCESC to exit the Status menu.  

The File menu provides two modes: All Files mode 
and Folder mode. Press SPACEBAR SPACEBAR SPACEBAR SPACEBAR while in the File 
menu to toggle between these modes. When in 
Folder mode, only the files in the current folder are 
listed. Press FN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROW or FN+UP ARROWFN+UP ARROWFN+UP ARROWFN+UP ARROW to 
move between folders, and then the DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW 
or UP ARROWUP ARROWUP ARROWUP ARROW key to move through the files in the 
current folder. RAM startup and Flash Startup are the 
default folders. 

CreatingCreatingCreatingCreating Folders Folders Folders Folders    

To create folders, you must be in the File menu in 
Folder mode. Press PLUSPLUSPLUSPLUS, type the folder name and 
press ENTERENTERENTERENTER, and then press RRRR for RAM or FFFF for Flash 
to indicate where the folder is to be located. Press 
ESCESCESCESC to exit the File menu. You can create up to 20 
folders. 



Part # 440001-001 Rev. B       41 

RenamingRenamingRenamingRenaming and  and  and  and Deleting FoldersDeleting FoldersDeleting FoldersDeleting Folders    

To rename a folder, press F1F1F1F1, move to the folder and 
press ALT+SHIFT+8ALT+SHIFT+8ALT+SHIFT+8ALT+SHIFT+8. Type in the new folder name and 
press ENTERENTERENTERENTER. 

To delete a folder, press F1F1F1F1, move to the folder and 
press DASHDASHDASHDASH. 

NoteNoteNoteNote: Only empty folders can be deleted. 

Moving FilesMoving FilesMoving FilesMoving Files    
There are two ways to move files into other folders. 
To move a single file into another folder: 

1. Press F1F1F1F1 to open the File menu. 

2. Press FN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROW or FN+UP ARROWFN+UP ARROWFN+UP ARROWFN+UP ARROW to 
move to the folder containing the file, then 
press DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW or UP ARROWUP ARROWUP ARROWUP ARROW to locate the 
file. 

3. Press SHIFT+NUM LOCKSHIFT+NUM LOCKSHIFT+NUM LOCKSHIFT+NUM LOCK. 

4. Select the folder to which you wish to move the 
file and press ENTERENTERENTERENTER. 

To move multiple files into a folder: 

1. Press F1F1F1F1 to open the file menu. 

2. Press SHIFT+COMMASHIFT+COMMASHIFT+COMMASHIFT+COMMA. 

3. A list of files is displayed. Use the UP ARROWUP ARROWUP ARROWUP ARROW 
and DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW keys to move through the 
listed files, or FN+UP ARROWFN+UP ARROWFN+UP ARROWFN+UP ARROW and FN+DOWN FN+DOWN FN+DOWN FN+DOWN 
ARROWARROWARROWARROW to move through folders. 
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4. Press SPACEBARSPACEBARSPACEBARSPACEBAR to mark each file you wish to 
move. 

5. Once all desired files are marked, press ENTERENTERENTERENTER. 

6. A list of folders is displayed. Locate the desired 
folder and press ENTERENTERENTERENTER. 

File CommandsFile CommandsFile CommandsFile Commands    
Many commands are available within the File menu. 
Several commands commonly used to work with 
folders have already been mentioned. Below are 
listed commonly used file commands. For a complete 
listing, refer to the Type Lite's onboard help 
(BREAKBREAKBREAKBREAK), or press F1F1F1F1, BREAKBREAKBREAKBREAK to open the File 
Commands menu. 

Create File CCCC 

Open Selected File ENTERENTERENTERENTER 

Rename Selected File ALT+RALT+RALT+RALT+R 

Rename Open File RRRR 

Delete Selected File ALT+DALT+DALT+DALT+D 

Delete Open File DDDD 

Write Protect Open File PPPP  

Unprotect Open File UUUU 

Password Protect Open File WWWW 
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Compact FlashCompact FlashCompact FlashCompact Flash    
When the Compact Flash™ utility is started, the 
files/folders on the Compact Flash module are 
displayed. Use UPUPUPUP ARROWARROWARROWARROW and DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW to 
move through the list of files and folders. Press TABTABTABTAB 
to switch between the note taker and the Compact 
Flash Module. When you TABTABTABTAB to the note taker, all 
RAM files are displayed. The following commands 
work in the Compact Flash utility: 

Help ???? 

Open Folder ENTERENTERENTERENTER 

Create Folder F7F7F7F7 

File Information ALT+IALT+IALT+IALT+I 

Delete File DELETEDELETEDELETEDELETE 

Up One Folder Level BACKSPACEBACKSPACEBACKSPACEBACKSPACE 

Mark Files SPACEBARSPACEBARSPACEBARSPACEBAR 

Press ALT+MALT+MALT+MALT+M to mark files based on a mask, such as 
*.txt. This includes only files from the open folder, 
and changing folders removes any marks. Press 
ALT+C ALT+C ALT+C ALT+C to copy all marked files or the current file. 
DELETEDELETEDELETEDELETE also deletes folders, but the folders must be 
empty. 

When you copy from the note taker to Compact Flash, 
files are copied to the folder last open in the Compact 
Flash module. When you copy from Compact Flash to 
the note taker, files are copied either into RAM 
Startup, or into the last RAM folder open before 
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accessing Compact Flash. You cannot copy from Flash 
to Compact Flash or from Compact Flash to Flash.  
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The Type Lite UtilitiesThe Type Lite UtilitiesThe Type Lite UtilitiesThe Type Lite Utilities    
The Type Lite is equipped with built-in utilities to 
help organize your busy life so your day runs more 
smoothly. The Type Lite includes a datebook, 
phonebook, stopwatch, and a calculator. 

The The The The Time and Time and Time and Time and DateDateDateDate    
The Type Lite tracks the time and date for you and 
can be set to announce the time on the hour. The 
Type Lite uses the date in conjunction with the 
Datebook to help you track appointments.  

Setting the Setting the Setting the Setting the TimeTimeTimeTime    
Set or change the time using one of two methods. 
Either enter the actual time, or add or subtract the 
increment of time from the current setting.  

1. Press F9F9F9F9 to open the Options menu. 

2. Press SSSS, TTTT for Set, Time. The Type Lite prompts 
you to Enter the time in hhmm format.  

Enter the exact time such as "0520" or enter the 
amount of time to add to or subtract from the current 
setting, such as "+0106" or "-0035." 

3. Press ENTERENTERENTERENTER after you have typed in the new 
time or an increment of time. 

4. If using American, 12 hour time, press AAAA for 
A.M. or PPPP for P.M. 
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The Type Lite displays time in either American, 12 
hour format, or in European 24 hour format.  

1. Press F9F9F9F9 to open the Options menu. 

2. Press SSSS for Set. 

3. Press 1111 for American, 12 hour time, or press 2222 
for European, 24 hour time. 

Setting Setting Setting Setting Hourly AnnouncementHourly AnnouncementHourly AnnouncementHourly Announcement    

The Type Lite can also announce the time on an 
hourly basis. 

1. Press F10F10F10F10 to open the Status menu. 

2. Press ALT+HALT+HALT+HALT+H to move to Hourly Announcement. 

3. Press SPACEBARSPACEBARSPACEBARSPACEBAR to cycle between: Off, Bell 
Only, Voice Only, and Bell and Voice. 

4. Press ESCESCESCESC to exit the status menu. 

Speech must be turned on for the voice settings to 
work. The bell settings work with speech turned off. 

Setting the Setting the Setting the Setting the DateDateDateDate    
To set the date: 

1. Press F9F9F9F9 to open the Options menu. 

2. Press SSSS, DDDD for Set, Date. 

3. Enter the date in "MMDDYY" format. 

The Smart CalThe Smart CalThe Smart CalThe Smart Calendarendarendarendar    
The Type Lite allows you to determine the day of the 
week it is on a particular date. Press SHIFT+F5SHIFT+F5SHIFT+F5SHIFT+F5 to 
open the Smart Calendar. 
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• Enter a date in the format MMDDYYYY and press 
ENTER. The Type Lite speaks/displays the 
weekday, month, day, and year. For example, if 
you enter "03162001," the Type Lite responds 
with "Friday March 16, 2001." 

• Enter a number of days, such as "15," to 
determine the day and date that many days 
from the current date. 

• Enter a number of days preceded by a minus (----) 
sign, such as "-12," to determine the day and 
date that many days ago. 

• Enter a number (####) sign to determine the 
current Julian date. The Julian date is the 
number of the day in the calendar year. 

The StopwatchThe StopwatchThe StopwatchThe Stopwatch        
The Stopwatch lets you measure elapsed time. Track 
how long you work in a file, or the length of a 
presentation.  

To enter the stopwatch, press SHIFT+F4SHIFT+F4SHIFT+F4SHIFT+F4. The 
following commands are then available: 

Start/Stop Count RIGHT ARROWRIGHT ARROWRIGHT ARROWRIGHT ARROW 

Reset Count LEFT ARROWLEFT ARROWLEFT ARROWLEFT ARROW 

Read Count SPACEBARSPACEBARSPACEBARSPACEBAR 

Last Reading CCCC 

Exit ESCESCESCESC 
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The Stopwatch continues counting, even if you exit it, 
unless you first stop or reset it. If you stop the 
Stopwatch, it retains the elapsed time last displayed 
when exited and restarted. If you turn off the Type 
Lite with the Stopwatch counting, once the Type Lite 
is started again, the Stopwatch count starts as well, 
but it starts from zero minutes, zero seconds. 

The The The The DatebookDatebookDatebookDatebook    
The Type Lite provides a Datebook for managing 
appointments. Enter important appointments such as 
meetings, birthdays, anniversaries, and interviews. 
Check your appointments at any time, or set the Type 
Lite to notify you on the days these appointments 
occur. 

There are three items under the Options menu 
relating to the Datebook. Press F9F9F9F9 or ALT+OALT+OALT+OALT+O to open 
the Options menu, then use the Arrow keys to move 
through the items. The access keys to move directly 
to each item are listed below in parentheses. 

Check AppointmentsCheck AppointmentsCheck AppointmentsCheck Appointments (A) (A) (A) (A)    

Select this item to check for any appointments on the 
current day. 

Open Datebook File (DELETE)Open Datebook File (DELETE)Open Datebook File (DELETE)Open Datebook File (DELETE)    

Select this item to open the Datebook file. Navigate 
this file as you would any other file. 

Datebook Entry (E)Datebook Entry (E)Datebook Entry (E)Datebook Entry (E)    
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Select this item to add an entry to the Datebook. You 
are prompted to enter a number of days or a date in 
MMDDYYYY format. After doing so, press ENTER. The 
Type Lite verifies the day and date of the 
appointment, and then prompts for the event text. 

At this point, there are two options: 

• Enter the event text and press ENTER.ENTER.ENTER.ENTER.  

• Press ALT+FALT+FALT+FALT+F. The Type Lite searches the 
Datebook for the selected date. If the date is not 
found, an entry for it is added and, "no 
appointments" is indicated. If the date is found, 
you are taken to that entry, and the first line of 
event text for that date is spoken/displayed. In 
either of these cases, you are in Browse Mode. 

Browse ModeBrowse ModeBrowse ModeBrowse Mode    
Browse Mode is a read only mode for reviewing 
Datebook entries. The following commands are 
available. 

To navigate information for the current date: 

Read/Display Date SHIFT+F1SHIFT+F1SHIFT+F1SHIFT+F1 

Previous Line UP ARROWUP ARROWUP ARROWUP ARROW 

Current Line CTRL+UP ARROWCTRL+UP ARROWCTRL+UP ARROWCTRL+UP ARROW 

Next Line  DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW 

First Line  ALT+8ALT+8ALT+8ALT+8 

Last Line  ALT+0ALT+0ALT+0ALT+0 

Start of Line FN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROW 
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End of Line FN+RIGHFN+RIGHFN+RIGHFN+RIGHT ARROWT ARROWT ARROWT ARROW 

To edit entries from Browse Mode: 

Press IIII to insert a new line before the current line, or 
press AAAA to append a new line to the end of the 
current entry. Type in the event text and press ENTERENTERENTERENTER 
to return to Browse Mode. 

Press EEEE to edit the current line. When finished, press 
ENTERENTERENTERENTER to return to Browse Mode. 

Press DDDD to delete the current line. Press YYYY to confirm, 
or NNNN to cancel. You are then returned to Browse 
Mode. 

To switch to entries for other dates from within 
Browse Mode: 

Prior Entry FN+UP ARROWFN+UP ARROWFN+UP ARROWFN+UP ARROW 

Next Entry FN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROW 

Get New Date GGGG 

Get New Date returns you to the Datebook entry 
prompt, requesting a number of days or a date in 
MMDDYYYY format. 

Press ESCESCESCESC to exit Browse Mode. 

Appointment NotificationAppointment NotificationAppointment NotificationAppointment Notification    
To set the Type Lite to check for appointments on the 
current day each time you start it: 

1. Press F10F10F10F10 to open the Status menu. 

2. Press JJJJ to move to Check Appointments. 
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3. Press YYYY to turn Check Appointments On. 

4. Press ESCESCESCESC to exit the Status menu. 

The The The The Phone BookPhone BookPhone BookPhone Book    
The Type Lite includes a phone book to manage 
contact information. The Phone Book tracks much 
more than just phone numbers. Manage names, 
addresses, phone numbers, email addresses, and 
more. 

There are two items under the Options menu relating 
to the Phone Book. Press F9F9F9F9 or ALT+OALT+OALT+OALT+O to open the 
options menu and use the Arrow keys to move to the 
items. The access keys to move directly to each item 
are listed below in parentheses. 

Open Phone BookOpen Phone BookOpen Phone BookOpen Phone Book (ALT+P) (ALT+P) (ALT+P) (ALT+P)    

Select this item to open the active phone book file. 
Navigate in this file as you would any other file. 

Phone book files contain the records you create when 
entering information into the Phone Book. You may 
have multiple phone files, but the first word in each 
should be "phone." For example, you may wish to 
have separate phone book files for personal and 
business contacts. One could be named "phone 
personal," and the other could be named "phone 
business." 

Phone BooPhone BooPhone BooPhone Book (P)k (P)k (P)k (P)    

Select this item to add phone book entries, or to 
create and configure phone book files. 
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Adding Phone Book EntriesAdding Phone Book EntriesAdding Phone Book EntriesAdding Phone Book Entries    
When you first press F9F9F9F9, PPPP, a list of fields is 
displayed. The Name field must always be populated 
with information. Records are alphabetized based on 
the Name field. Use a consistent naming scheme, 
such as Last name, First Name. Use consistent 
capitalization as capitalization is considered when 
records are organized within phone book files. 
Consistent naming schemes and consistent 
capitalization make it easier to locate individual 
records in the Phone book file.  

To fill in the fields for a phone book entry: 

• Type in the information for each field and press 
ENTERENTERENTERENTER to move to the next field.  

• Press UP ARROWUP ARROWUP ARROWUP ARROW or DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW to move 
through the available fields. Field names are 
indicated as you move through them. 

• Press SHIFT+F3SHIFT+F3SHIFT+F3SHIFT+F3 followed by the first letter of a 
field name to move to a specific field. 

• Press ENTERENTERENTERENTER in an empty comment field, or 
press ALT+FALT+FALT+FALT+F when finished. 

NoteNoteNoteNote: When entering information, BACKSPACEBACKSPACEBACKSPACEBACKSPACE is 
the only available editing option. 

Phone Book OptionsPhone Book OptionsPhone Book OptionsPhone Book Options    
Press ALT+OALT+OALT+OALT+O from the list of field names to access 
configuration options for the Phone Book. This opens 
a menu containing three items: 
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Setup Field NamesSetup Field NamesSetup Field NamesSetup Field Names    

This item presents a list of all available fields and 
indicates On or Off for each of them. 

• Use the Arrow keys to cycle through the list and 
press SPACEBARSPACEBARSPACEBARSPACEBAR to toggle fields between On 
and Off. 

• Press PPPP to enable those fields commonly used in 
a personal phone book. 

• Press BBBB to enable those fields commonly used in 
a business phone book. 

• Press ZZZZ to enable all fields. 

• Press ESC ESC ESC ESC to return to the Phone Options menu. 

Select Phone FileSelect Phone FileSelect Phone FileSelect Phone File    

This item presents a list of all phone book files with 
names beginning with "phone," and lets you specify 
which phone book file is active. Phone book entries 
are always saved in the active phone book file. 

• Use the Arrow keys to cycle through the list and 
press ENTERENTERENTERENTER on the file you want active. 

• Press NNNN to create a new phone book file and set 
it as active. Also use this option to activate a 
phone book file with a name that does not begin 
with "phone." 

NoteNoteNoteNote: Phone Book files contain the phone records 
you enter. They can have any file name, but 
are only listed under Select Phone File if 
their name begins with "phone."  
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Reinitialize Phone BookReinitialize Phone BookReinitialize Phone BookReinitialize Phone Book    

This item resets several phone related settings: 

• The default phone book file, Phone, is set as 
active. 

• All fields are turned on in all phone book files 
with names beginning with "phone." 

• Phone book files with names that do not begin 
with "phone" are only affected if they are active 
when Reinitialize Phone Book is selected. 

Press ESCESCESCESC to exit from any of the phone book 
configuration options. You may need to press ESCESCESCESC 
twice to return to the list of fields in which 
information is entered. 

The CalculatorThe CalculatorThe CalculatorThe Calculator    
The Type Lite calculator is very robust with both 
standard and scientific functions.  

Basic OperationsBasic OperationsBasic OperationsBasic Operations    
• To open the Calculator, press F3F3F3F3.  

• To exit the Calculator, press ESCESCESCESC. 

• Press CTRL+UP ARROW CTRL+UP ARROW CTRL+UP ARROW CTRL+UP ARROW to hear the information 
currently displayed in the Calculator.  

• Press F3F3F3F3 to clear the Calculator. 

• Press F2F2F2F2 to toggle between speaking digits or 
full numbers. 
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Standard operations are entered in the form A+B, 
with no spaces between the values and the 
operators. Press ENTERENTERENTERENTER to calculate the expression.  

The standard operators are: 

+ = plus 

- = minus 

* = times 

/ = divide 

% = percent 

F1 = square root 

Performing Percentage CalculationsPerforming Percentage CalculationsPerforming Percentage CalculationsPerforming Percentage Calculations    

To determine the value of a percentage of a number, 
type the value of the percentage, the percent sign, 
and the number from which you wish to derive the 
percentage. Press ENTERENTERENTERENTER to calculate the expression. 
For example, to find 20 percent of 500, enter 
20%500, and press ENTERENTERENTERENTER. The Type Lite calculates 
the expression and returns "100." 

Extracting a Square RootExtracting a Square RootExtracting a Square RootExtracting a Square Root    

To extract the square root of a number, type the 
number, then press F1F1F1F1. For example, to find the 
square root of 25, type 25 and press F1F1F1F1. The Type 
Lite immediately calculates the expression and 
returns “5.” 
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Setting Decimal PrecisSetting Decimal PrecisSetting Decimal PrecisSetting Decimal Precisionionionion    

The Calculator's results vary according to the number 
of decimal places to which your calculator is set. Two 
decimal places are enough for most situations; 
however, results can be calculated to 12 decimal 
places.  

From within the calculator, press ALT+PALT+PALT+PALT+P. The Type 
Lite prompts for the number of decimal places. Enter 
a number from 1 to 12. 

NoteNoteNoteNote: The Calculator drops ending zeros to the 
right of the decimal point. A value of 1.20 
is displayed as 1.2, even if decimal 
precision is set to 2. 

The Embedded KeypadThe Embedded KeypadThe Embedded KeypadThe Embedded Keypad    
The Type Lite provides access to an embedded 
keypad while in the Calculator. Press NUM LOCKNUM LOCKNUM LOCKNUM LOCK to 
toggle the embedded keypad on and off. Once the 
embedded keypad is on, the following keys are 
treated as numbers: 

7, 8, and 9 are not changed, but 0 is treated as * 
(times). 

U, I, O, and P are treated as 4, 5, 6, and - (minus). 

J, K, L, and ; are treated as 1, 2, 3, and +. 

M is treated as 0. 
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Scientific CalculatorScientific CalculatorScientific CalculatorScientific Calculator Functions Functions Functions Functions    
The scientific calculator functions all use the same 
syntax. Type in the function name, followed by the 
arguments surrounded in parentheses. If there are 
multiple arguments, separate them with commas. 
Expressions cannot exceed 255 characters. 

To determine an average, type AVGAVGAVGAVG(#,#,#) and 
press ENTERENTERENTERENTER.  

To calculate the median, type MEDIAN(#,#,#)MEDIAN(#,#,#)MEDIAN(#,#,#)MEDIAN(#,#,#) and 
press ENTERENTERENTERENTER.  

To generate a random number between 0 and 1, type 
RAND()RAND()RAND()RAND() and press ENTERENTERENTERENTER. 

To determine the square root of a number, type 
SQRT(#)SQRT(#)SQRT(#)SQRT(#) and press ENTERENTERENTERENTER. 

Trigonometric FunctionsTrigonometric FunctionsTrigonometric FunctionsTrigonometric Functions    

To calculate the sine of 90 degrees or pi/2 radians, 
type SIN(90)SIN(90)SIN(90)SIN(90) and press ENTERENTERENTERENTER. The Type Lite 
returns, “One.” The Calculator default is in degrees. 

To switch to radians, press ALT+RALT+RALT+RALT+R. Type SIN(pi/2)SIN(pi/2)SIN(pi/2)SIN(pi/2) 
and press ENTERENTERENTERENTER. The Type Lite returns, “one.”  

Press ALT+RALT+RALT+RALT+R again to switch back to degrees. Other 
trigonometric functions are: 

Cosine COSCOSCOSCOS 

Tangent TANTANTANTAN 

Cotangent COTCOTCOTCOT 
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Arcsine ASINASINASINASIN 

Arccosine ACOSACOSACOSACOS 

Arctangent ATANATANATANATAN 

Base e log LNLNLNLN 

Base 10 Log LOGLOGLOGLOG 

Base e antilog ALNALNALNALN 

Base 10 antilog ALOGALOGALOGALOG 

ConversionsConversionsConversionsConversions    

The Calculator provides functions for many 
conversions. Enter the value of what you wish to 
convert from as the argument. Remember that 
arguments must be contained within parentheses. 

HDHDHDHD Decimal to Hexadecimal 

ODODODOD Decimal to Octal 

BDBDBDBD Decimal to Binary 

DHDHDHDH Hexadecimal to Decimal 

DODODODO Octal to Decimal 

DBDBDBDB Binary to Decimal 

FARENFARENFARENFAREN Centigrade to Fahrenheit 

CENTICENTICENTICENTI  Fahrenheit to Centigrade  

ININININ Centimeter to Inches 

CMCMCMCM Inches to Centimeters 
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MIMIMIMI Kilometers to Miles 

KMKMKMKM Miles to Kilometers 

LLLL Gallons to Liters 

GALGALGALGAL Liters to Gallons 

KGKGKGKG Pounds to Kilograms 

LBLBLBLB Kilograms to Pounds 

GGGG Ounces to Grams 

OZOZOZOZ Grams to Ounces 

Storing and Using the MemoryStoring and Using the MemoryStoring and Using the MemoryStoring and Using the Memory Locations Locations Locations Locations    
The Type Lite calculator has 26 memory locations 
where you can store results of computations. These 
memory locations are labeled A through Z. Memory 
location R is reserved because it stores your last 
result.  

There are two ways to store a number in a memory 
location.  

1. Type an arithmetic expression and press ENTERENTERENTERENTER 
to compute the result.  

2. Press F4F4F4F4 or ALT+SALT+SALT+SALT+S to store the result.  

3. Type the letter of the memory location you wish 
to use.  

The second method is to type a number into the 
Calculator, press ENTERENTERENTERENTER, type F4F4F4F4, and specify the 
memory location you wish to use. 
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To read the contents of a memory location, type the 
letter of that location followed by ENTERENTERENTERENTER. 

To use numbers stored in different memory locations 
as part of an expression, reference the memory 
location in your expression. For example, if you have 
numbers stored in memory locations A and B, the 
expression A+B followed by ENTER ENTER ENTER ENTER returns the sum 
of these two numbers.
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MacrosMacrosMacrosMacros    
A macro is a set of recorded keyboard commands that 
automates a given task. One keyboard command 
starts the macro, and the entire series of commands 
assigned to it are executed. Using macros can 
significantly increase your productivity because it 
allows you to automate frequently used tasks. Use 
macros for repetitive or complex tasks such as 
inserting your name and address into a document, 
launching a program, or copying and pasting data 
from one file to another. 

The first time you create a macro, the unit 
automatically creates a file called Macros.sys. When 
recording macros, keep the following points in mind:  

• There is a maximum limit of 64 macros, with 
each macro comprising a maximum of 63 
keystrokes. 

• Carefully plan and record macros to avoid 
keystroke errors. (This is very important when 
creating a macro that edits text or manipulates 
files.) 

Recording a MacroRecording a MacroRecording a MacroRecording a Macro    
To record a macro, start the recording and specify the 
key that is used to execute it, then perform the steps 
that are to be included in the macro. It is important 
to position yourself at the point where you are going 
to use the macro you are recording so as to ensure 
your key commands are accurate. For example, if you 
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wish to record a macro to insert a commonly used 
closing at the end of a letter, position yourself at the 
end of a file before you start recording the macro. 

1. Press ALT+N to start the macro recorder. 

2. Type the character to which you wish to assign 
the macro. You are prompted that recording has 
started. 

3. Perform the steps of your macro. 

4. Press ALT+NALT+NALT+NALT+N to complete the recording or press 
ESCESCESCESC to abort the recording. 

ExecutingExecutingExecutingExecuting a Macro a Macro a Macro a Macro    
Press FN plus the key to which you assigned a macro 
to run it. 

Speaking or Silencing MacrosSpeaking or Silencing MacrosSpeaking or Silencing MacrosSpeaking or Silencing Macros    
Press ALT+VALT+VALT+VALT+V to turn Speak macros on. Press ALT+KALT+KALT+KALT+K to 
silence macros. 

Nesting MacrosNesting MacrosNesting MacrosNesting Macros    
Existing macros can be referenced and run from 
within other macros. This process is called nesting. 
To nest a macro, first record your new macro, then at 
the point you want the existing macro to run, press 
FN plus FN plus FN plus FN plus the letter to which the existing macro is 
assigned.    
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Start Up MacrosStart Up MacrosStart Up MacrosStart Up Macros    
A start up macro plays every time you power up the 
Type Lite. To create a Start Up Macro, press ALT+NALT+NALT+NALT+N, 
followed by SPACEBARSPACEBARSPACEBARSPACEBAR. The Type Lite prompts for 
verification. Press YYYY to continue, or NNNN to cancel. If you 
wish to proceed, just record the macro as normal. 

NoteNoteNoteNote: If a start up macro causes difficulties in the 
operation of your Type Lite, bypass running 
it by pressing and holding down SPACEBARSPACEBARSPACEBARSPACEBAR 
during power on. 

Erasing MacrosErasing MacrosErasing MacrosErasing Macros    
To erase a macro, press ALT+NALT+NALT+NALT+N followed by the key to 
which the macro is assigned, and press ALT+NALT+NALT+NALT+N again. 

NoteNoteNoteNote: When erasing start up macros, after 
pressing ALT+NALT+NALT+NALT+N, SPACEBARSPACEBARSPACEBARSPACEBAR, you are 
prompted to confirm that you wish to 
proceed. Press YYYY to confirm and press 
ALT+NALT+NALT+NALT+N to erase the start up macro. 

Write Write Write Write Protecting MacrosProtecting MacrosProtecting MacrosProtecting Macros    
Write protect your macros to ensure they are not 
accidentally overwritten.  

• To write protect all macros, press ALT+NALT+NALT+NALT+N, ALT+PALT+PALT+PALT+P. 

• To unprotect all macros, press ALT+NALT+NALT+NALT+N, ALT+UALT+UALT+UALT+U. 
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Printing and EmbossingPrinting and EmbossingPrinting and EmbossingPrinting and Embossing    
Most printers use the parallel port, and most 
embossers use the serial port. If you are going to 
connect the Type Lite to an embosser through the 
serial port, the Status menu (F10F10F10F10) serial parameters 
settings must match those on the embosser. 

The files in the Type Lite Editor are plain text. They 
contain no layout or character level formatting 
information such as bold, italic, or underline. You 
must specify within the document how certain text is 
to be formatted when printed or embossed. 
Formatting commands - strings of characters 
included in your files - affect text layout and 
character appearance. The formatting characters are 
not printed or embossed; they just provide 
instructions to your printer or embosser on how to 
render the document. 

Status Menu SettingsStatus Menu SettingsStatus Menu SettingsStatus Menu Settings    
There are several settings within the Status menu 
that control how documents are printed or embossed. 
For basic documents, minor adjustments to these 
settings may be sufficient to provide the formatting 
features you wish to use. 

Press F10F10F10F10 to open the Status menu; then press 
FN+DOWFN+DOWFN+DOWFN+DOWN ARROWN ARROWN ARROWN ARROW to move through the sections of 
this menu until "Format Parameters" is indicated. 
This section of the Status menu contains the 
following items. 
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Printer CompatibilityPrinter CompatibilityPrinter CompatibilityPrinter Compatibility    
This item specifies the type of printer to wich you are 
printing. The available settings are: 

• Printer is Epson Compatible 

• Printer is Imagewriter 

• Printer is HP 

Toggle between the settings with SPACEBAR. If you 
do not use one of these printer brands, check your 
printer documentation for information on 
"compatibility" or "emulation." If you are able to set 
your printer to emulate one of these brands, or if 
your printer is compatible with one of these brands, 
it should work with the Type Lite. The Type Lite is 
designed for use with "character based" printers - 
printers that work in DOS. Windows only printers may 
not work with the Type Lite. 

Page NumberingPage NumberingPage NumberingPage Numbering    
Number Pages specifies whether or not page 
numbers are included in your printed and embossed 
documents.  

Put Page Number on First Page determines if the 
first page of your document includes a page number. 

Document LayoutDocument LayoutDocument LayoutDocument Layout    
Several Status menu items allow you to control 
overall layout of your printed or embossed 
documents. These items are listed here with their 
default values.  
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Double Space (Off) specifies whether the document 
is single or double spaced. This setting applies to 
both printed and embossed documents. 

There are several Status menu items that only affect 
how documents are printed: 

• Print Line Length (75) 

• Print Left Margin (10) 

• Print Page Length (60) 

• Print Top Margin (6) 

There are also several Status menu items that only 
affect how documents are embossed: 

• Braille Line Length (33) 

• Braille Left Margin (1) 

• Braille Page Length (25) 

• Braille Top Margin (1) 

Formatting CommandsFormatting CommandsFormatting CommandsFormatting Commands    
Formatting commands are inserted into the text of 
your documents to produce results that cannot be 
achieved through the more generall formatting 
settings in the Status menu. We recommend you add 
formatting commands as a last step before printing 
or embossing a document. 

SyntaxSyntaxSyntaxSyntax    
Formatting commands must be entered in a specific 
manner to work properly. If you have ever worked 
with HTML and left out a closing tag, or forgotten a 
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required quotation mark, you already understand the 
need to use the proper syntax in order to achieve the 
results you desire. 

• All formatting commands begin with the dollar 
sign ($). 

• All formatting commands must have an empty 
space on either side of them. For example, to 
bold text: The word $BB bold $BF will print in a 
boldface font. 

• Many formatting commands contain two 
elements, one to begin the formatting, and one 
to end it. If the ending element is left out, the 
printer does not know to stop applying that 
formatting. 

• Many formatting commands must be entered in 
documents at certain locations relative to the 
text you wish them to affect. For example, when 
centering a line of text, the center command ( 
$C ) must be on each line that is to be centered. 

• Many formatting commands require a value as 
part of the command. This must be included 
directly after the command, before the space. 
For example, to set a tab size of five characters, 
enter the command ( $TS5 ). 

The following sections list the available formatting 
commands. All commands are surrounded by 
parentheses, but the surrounding parentheses are 
not part of the command. If a numeric value is 
required as part of a command, this is indicated with 
the number sign (#). 
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Attribute MarkingAttribute MarkingAttribute MarkingAttribute Marking    
Formatting commands related to attribute marking 
apply only to documents that are to be printed. 

Bold Begin ( $BB ) 

Bold Finish ( $BF ) 

Italic Begin ( $IB ) 

Italic Finish ( $IF ) 

Double Strike Begin ( $DBSB ) 

Double Strike Finish ( $DBSF ) 

Strike Out Begin ( $SOB ) 

Strike Out Finish ( $SOF ) 

Underline Begin ( $UB ) 

Underline Finish ( $UF ) 

Margins and AlignmentMargins and AlignmentMargins and AlignmentMargins and Alignment    
Commands for adjusting margins work for both print 
and embossed documents. Some of the alignment 
commands also work for both print and embossed 
documents, but some of them only apply to print 
documents.  

When adjusting margins, it is essential to consider 
the related settings within the Status menu.  

Set Left Margin ( $ML# ) 

Set Right Margin ( $MR# ) 
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Set Top Margin ( $MT# ) 

Set Bottom Margin ( $MB# ) 

Note: The bottom margin defaults to 0 for print 
documents. If page numbering is turned 
on, this changes to 6. Embossed documents 
use a default bottom margin of 0. 

Set Page Length ( $PL# ) 

Set Page Width ( $PW# ) 

Increase Left Margin ( $ML+# ) 

Decrease Left Margin ( $ML-# ) 

Increase Right Margin ( $MR+# ) 

Decrease Right Margin ( $MR-# ) 

Increase Top Margin ( $MT+# ) 

Decrease Top Margin ( $MT-# ) 

Increase Bottom Margin ( $MB+# ) 

Decrease Bottom Margin ( $MB-# ) 

Outdent Left Margin 1 Tab Stop ( $OUT ) 

Center Current Line ( $C ) 

NoteNoteNoteNote: The center command must be on every line 
of text that is to be centered. If the text 
wraps to a new line when printed or 
embossed, the text that wraps will not be 
centered. 

Right Justification ( $JR ) 
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No Justification ( $JN ) 

Full Justification ( $JF ) 

NoteNoteNoteNote: Full justification does not work with 
embossed files. 

Set Line Spacing ( $LS# ) 

This setting lets you override the Status menu 
setting. For example, in a double spaced term paper, 
long quotations should be single spaced. 

TabsTabsTabsTabs    
Tabs work in a similar manner to that in a word 
processing program on a personal computer. The tab 
size is measured in spaces from the character or 
space typed in the document just prior to the tab. 

Set Tab Size ( $TS# ) 

Insert Tab ( $T ) 

Set Tab Stop ( $TO# ) 

NoteNoteNoteNote: Once you set the tab size, the insert tab 
command uses this setting. However, to 
use the tab stop, you must use that 
command each time rather than the insert 
tab command. 

Page NumberingPage NumberingPage NumberingPage Numbering    
Page numbering is enabled or disabled in the Status 
menu, but for finer control of how your pages are 
numbered, use the following format commands. If 
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page numbering in the Status menu is turned off, 
these commands have no effect. 

Numbering TypeNumbering TypeNumbering TypeNumbering Type    

Arabic Numbers ( $PNAR ) 

Roman Numerals ( $PNRN ) 

No Numbering ( $PNNP ) 

Start Numbering at ( $PN# ) 

Numbering PositionNumbering PositionNumbering PositionNumbering Position    

Top Left ( $PNTL ) 

Top Center ( $PNTC ) 

Top Right ( $PNTR ) 

Bottom Left ( $PNBL ) 

Bottom Center ( $PNBC ) 

Bottom Right ( $PNBR ) 

Headers and FootersHeaders and FootersHeaders and FootersHeaders and Footers    
Use headers and footers to place the same text at 
the top or bottom of each page of a printed or 
embossed document. 

Header Begin ( $HB ) 

Footer Begin ( $FB ) 

End Header/Footer Text ( $- ) 
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To indicate the text you wish to use as a header or 
footer, specify the appropriate command listed above 
followed by the text and any formatting commands 
you wish to use (such as center, bold, or italic). Then 
insertthe the End Header/Footer Text command. This 
text will appear at the top or bottom of each printed 
or embossed page, formatted as you specify with 
other formatting commands.  

Disable Header ( $H- ) 

Reenable Header ( $H+ ) 

Disable Footer ( $F- ) 

Reenable Footer ( $F+ ) 

Other CommandsOther CommandsOther CommandsOther Commands    
New Line ( $L ) 

New Paragraph ( $P ) 

New Page ( $F ) 

Insert Current Time ( $TM ) 

Insert Current Date ( $DT ) 

Start Ignore Text ( $( ) 

End Ignore Text ( $) ) 

Respect Braille Translator Setting ( $BRL+ ) 

No Translation ( $BRL- ) 

NoteNoteNoteNote: The Braille translator settings only affect 
embossed documents. 
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Don't Formfeed After Print ( $NF ) 

Wait for a Keypress  

After Each Page is Printed ( $W ) 

End Formatting ( $EF ) 

Information CommandsInformation CommandsInformation CommandsInformation Commands    
Show Formatting Progress ( $ST ) 

Pages Printed SPACEBARSPACEBARSPACEBARSPACEBAR 

Percent Printed ALT+:ALT+:ALT+:ALT+:    

Print CommandsPrint CommandsPrint CommandsPrint Commands    
Print Commands affect how files are printed or 
embossed. 

To send the open file to the serial port, press F12F12F12F12. To 
send the open file to the parallel port, press 
SHIFT+F12SHIFT+F12SHIFT+F12SHIFT+F12. After pressing one of these keyboard 
combinations, specify which parameters you wish to 
use. 

Formatted Text AAAA or TTTT 

Formatted Braille BBBB 

Line LLLL 

From Cursor 
to Mark MMMM 

Paragraph PPPP 

Unformatted File SSSS 
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Braille Translation 
without Formatting WWWW 

This parameter is used if importing a file into a word 
processor. 

Translate to 
Formatted Grade 2 2222 

Translate to Grade 2 
(No Formatting) SEMISEMISEMISEMI----COLONCOLONCOLONCOLON 

From Cursor to 
End of File ZZZZ 

Print to File FFFF 

Print to file only works through the serial port. When 
using this command, you are asked for one of the 
preceding parameters, then for a destination file 
name. 
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Connecting to a Personal ComputerConnecting to a Personal ComputerConnecting to a Personal ComputerConnecting to a Personal Computer    
The Type Lite serves as a refreshable Braille display 
for your screen access software, or you can just 
connect it to your PC for easy and convenient file 
transfers. You can also use the external disk drive - 
available from Freedom Scientific - to move files 
between your PC and the Type Lite via disk. 

JAWS and Connect OutloudJAWS and Connect OutloudJAWS and Connect OutloudJAWS and Connect Outloud    
The Type Lite provides tactile access to JAWS and 
Connect Outloud supported applications. Toggle the 
switch on the left edge of the Type Lite toward the 
front of the unit to enter Braille Display mode. The 
Type Lite should be connected to your PC through the 
serial port, powered on, and toggled to Braille 
Display mode before JAWS or Connect Outloud is 
started. 

Refer to the JAWS or Connect Outloud online help 
systems for information on Type Lite specific 
commands to interact with these applications and the 
programs they support. 

WinDiskWinDiskWinDiskWinDisk and the Type Lite and the Type Lite and the Type Lite and the Type Lite    
The WinDisk program provides support for the Type 
Lite in Windows. WinDisk allows you to access the 
files and folders on the Type Lite as though they 
were just on another drive. Once installed, WinDisk 
displays the Type Lite's files and folders in Windows 
Explorer and My Computer. Copy and paste files in 
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either direction with standard Windows keystrokes. 
Additionally, WinDisk provides a one step back up 
and restore feature for the entire file and folder 
system of the Type Lite. 

RequirementsRequirementsRequirementsRequirements    
WinDisk only runs onPersonal Computers running 
Windows 9x, Windows NT 4.0, Windows 2000 or 
Windows ME. 

The Type Lite is connected to the computer via a 
serial port. Other devices cannot use the same serial 
port while you are using WinDisk. 

The Type Lite cannot be used as a refreshable Braille 
display with JAWS or Connect Outloud while using 
WinDisk. JAWS can be configured so the Braille 
display goes into sleep mode whenever you open My 
Computer or Windows Explorer. To set JAWS to do 
this: 

1. With JAWS running, open Windows Explorer. 

2. Press INSERT+F2INSERT+F2INSERT+F2INSERT+F2, select Configuration Manager, 
and press ENTERENTERENTERENTER. 

3. Press ALT+SALT+SALT+SALT+S, BBBB to open Braille Options. 

4. Press TABTABTABTAB until you arrive at the Braille Sleep 
Mode checkbox. 

5. Press SPACEBARSPACEBARSPACEBARSPACEBAR to check this item. 

6. Press ENTERENTERENTERENTER, then CTRL+SCTRL+SCTRL+SCTRL+S to accept and save 
changes. 

7. Press ALT+F4ALT+F4ALT+F4ALT+F4 to exit Configuration Manager. 
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Installing WinDiskInstalling WinDiskInstalling WinDiskInstalling WinDisk        
When you insert the WinDisk CD into your computer's 
CD drive, the install wizard runs. If you have JAWS 
loaded, the entire installation process is accessible.  

Type Lite SettingsType Lite SettingsType Lite SettingsType Lite Settings    
The Type Lite must be configured properly to 
communicate with your computer and WinDisk. 
Connect the Type Lite to your computer with the 
serial cable supplied with your Type Lite. 

Press F10F10F10F10 to open the status menu and set the 
following serial parameters: 

• 38,400 baud 

• no parity 

• 8 data bits 

• 1 stop bit 

• hardware handshaking 

Press ESC ESC ESC ESC to Exit the status menu after these 
settings are configured.  

Press F9F9F9F9, ALT+WALT+WALT+WALT+W to enter WinDisk mode. The Type 
Lite indicates, "WinDisk mode, press z chord or 
escape to abort." The Type Lite is now ready to 
communicate with the PC. 

Using WinDiskUsing WinDiskUsing WinDiskUsing WinDisk    
Once the Type Lite is connected and in WinDisk 
mode, start Windows Explorer or My Computer. If 
WinDisk is installed, a new entry - Blazie Engineering 
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Note-taker - is displayed. The Freedom Scientific icon 
marks this entry. When you move to and open this 
item, a list of all folders in the Type Lite is displayed. 
The folders are listed alphabetically, and each folder 
name is followed by either the letter R or F in 
parentheses. This indicates whether the folder 
contains RAM or flash files. Even when the Type Lite 
is set to all files mode, a minimum of two folders 
appear, Ram Startup and Flash Startup.  

NoteNoteNoteNote: Moving to the Blazie Engineering note-
taker entry before the Type Lite is 
connected, powered on, and in WinDisk 
mode, may result in your system hanging 
or freezing. 

To view the files within a folder: 

• Select the desired folder in the tree view and 
view the files in the list view of Windows 
Explorer.  

• Select the folder in the list view of Windows 
Explorer or My Computer and press ENTERENTERENTERENTER to 
open the folder. 

WinDiskWinDiskWinDiskWinDisk Commands Commands Commands Commands    
WinDisk uses standard copy and paste commands 
when copying files to and from the Type Lite. 

Copy File CTRL+CCTRL+CCTRL+CCTRL+C 

Paste File CTRL+VCTRL+VCTRL+VCTRL+V 

Select All CTRL+ACTRL+ACTRL+ACTRL+A 
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The status of file transfers is indicated by the Type 
Lite. Entire folders cannot be copied or pasted. To 
copy all the contents of a folder, You must open the 
folder and select all files (CTRL+ACTRL+ACTRL+ACTRL+A), then press 
CTRL+CCTRL+CCTRL+CCTRL+C to copy the selected files to the clipboard. 

NoteNoteNoteNote: Cut (CTRL+XCTRL+XCTRL+XCTRL+X) is not available.  

Backup and RestoreBackup and RestoreBackup and RestoreBackup and Restore    
To backup all Type Lite files, press CTRL+B CTRL+B CTRL+B CTRL+B from 
within the Blazie Engineering note-taker entry or one 
of its subfolders. WinDisk keeps track of the folders 
from which each file was backed up, and remembers 
if the files were in RAM or flash memory. By default, 
WinDisk stores the files in a folder named backup, 
one level below the WinDisk folder. This is 
C:\windisk\backup if WinDisk was installed into the 
default folder.  

WinDisk provides support for a single backup set 
only. If a backup set has previously been created, 
move or delete the existing backup set before 
creating a new one. If you do not move, rename or 
delete the existing WinDisk backup folder prior to 
starting a new backup, files may be duplicated or 
destroyed. 

To restore Type Lite files from a back up set, press 
CTRL+RCTRL+RCTRL+RCTRL+R from within the Blazie Engineering entry or 
one of its subfolders. The restore process rebuilds 
the Type Lite file and folder system as necessary to 
restore the Type Lite to the same condition it was in 
when the backup was created. For example, if a 
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complete reinitialization of the Type Lite has been 
performed - erasing all files and folders in the unit - 
the restore process rebuilds the folder system and 
automatically transfers all files into the appropriate 
folders. This command is intended to be used after 
the unit has been reinitialized, erasing all file and 
folder names.  

WarningWarningWarningWarning: The restore process erases files on the Type 
Lite that have the same name as the files 
being restored from the PC. For example, if 
WinDisk is restoring the file phone, but the 
Type Lite still has a file named phone 
inside it, the phone file inside the Type Lite 
is deleted and replaced with the copy being 
restored from the PC.  

Leaving WiLeaving WiLeaving WiLeaving WinDisknDisknDisknDisk    
As WinDisk is integrated into the Windows interface, 
the program cannot really be closed on the PC. 
Before you leave WinDisk mode on the Type Lite, 
navigate away from the Blazie Engineering note-taker 
entry in Windows Explorer or My Computer, or close 
the Windows Explorer or My Computer window. Once 
this is done, press ESC ESC ESC ESC on the Type Lite to exit 
WinDisk mode. 

Trouble ShootingTrouble ShootingTrouble ShootingTrouble Shooting    
If you experience difficulties with the WinDisk 
program, refer to the WinDisk.doc or WinDisk.txt files 
that are distributed with the program. 
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The External Disk DriveThe External Disk DriveThe External Disk DriveThe External Disk Drive    
Freedom Scientific offers an external disk drive that 
works well with the Type Lite. Use the disk drive to 
copy files to and from the Type Lite, and from the 
disk, to and from your PC. Use the cable provided 
with this drive to connect it to the disk drive port on 
the back of the unit. This port is just to the right of 
the Compact Flash slot, and is labeled in Braille as 
"dd." 

After connecting the disk drive, power on the Type 
Lite and the disk drive. Insert a disk and press 
SHIFT+F8SHIFT+F8SHIFT+F8SHIFT+F8 to access the disk drive storage menu. Use 
the Arrow keys to move through the menu, and press 
ENTER to select the options you wish to use. 

The recommended option for copying files to and 
from the disk drive is Y-modem transfers. Press YYYY to 
select this item. You are prompted to press SSSS to send 
or RRRR to receive.  

Send OptionsSend OptionsSend OptionsSend Options    
If you choose to send, you have several options: 

• Press SPACEBAR SPACEBAR SPACEBAR SPACEBAR to mark the selected file. Arrow 
through the list to select all files you wish to 
send to the disk drive. 

• Press RRRR to mark all RAM files. 

• Press FFFF to mark all Flash files. 

Press ENTERENTERENTERENTER when complete, and the transfer begins. 
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Receiving from the Disk DriveReceiving from the Disk DriveReceiving from the Disk DriveReceiving from the Disk Drive    
After Selecting Y-modem transfers, If you choose RRRR 
to receive from the disk drive, you are prompted to 
indicate what you wish to receive. 

• Type the name of a file located on the disk in 
the disk drive and press ENTERENTERENTERENTER. 

• Type in a file mask, such as *.txt or *.* and press 
ENTERENTERENTERENTER. 

File masks use wild card characters to fill in the parts 
of the file names that are not specified. For example, 
*.txt indicates to copy all files ending in .txt. *.* 
indicates to copy all files. 

For more information, refer to the external disk 
drive's manual. 
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Care and MaintenanceCare and MaintenanceCare and MaintenanceCare and Maintenance    
The Type Lite is a complex electronic device and must 
be cared for properly to maintain it at peak 
performance. This section discusses caring for the 
Type Lite, updating to the latest firmware, and basic 
troubleshooting steps to take in case the Type Lite 
stops functioning properly. 

The Battery and AC AdapterThe Battery and AC AdapterThe Battery and AC AdapterThe Battery and AC Adapter    
The Type Lite is designed to run on battery power 
most of the time. You should receive approximately 
30 hours of battery life before needing to recharge it. 
If you leave your Type Lite powered off except when 
you need to use it, you may only need to charge your 
battery once a week or so. 

To charge the battery, just plug the Type Lite in with 
the AC adapter overnight. The Type Lite can be used 
while connected to the AC adapter, but it should not 
be left connected for days or weeks at a time. 

Use only the AC adapter that came with your Type 
Lite. Do not attempt to use AC adapters received with 
other Freedom Scientific note takers. Doing so may 
cause permanent damage. 

Resetting the Type LiteResetting the Type LiteResetting the Type LiteResetting the Type Lite    
The Type Lite, like any complex computing system, 
occasionally may lock, freeze, or seem to function 
sluggishly. If this occurs regularly, Freedom Scientific 
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hardware technical support should be contacted. 
However, if this occurs only infrequently, there are 
steps to take that should get you back up and 
running without delay. 

Warm ResetWarm ResetWarm ResetWarm Reset    
Press ALT+CTRL+DELETEALT+CTRL+DELETEALT+CTRL+DELETEALT+CTRL+DELETE to warm reset your Type 
Lite. A warm reset does not affect your files, but all 
settings you have configured are reset to defaults. 

If the first warm reset does not help, press and hold 
down ALT+CTRL+DELETE ALT+CTRL+DELETE ALT+CTRL+DELETE ALT+CTRL+DELETE during power on. 

Cold ResetCold ResetCold ResetCold Reset    
A cold reset may result in loss of all files on the Type 
Lite so this should be used only as a last resort. 
Press and hold down ALT+CTRL+LEFT WINDOWS KEYALT+CTRL+LEFT WINDOWS KEYALT+CTRL+LEFT WINDOWS KEYALT+CTRL+LEFT WINDOWS KEY 
during power on to cold reset your Type Lite. This 
resets your unit to its default parameters and erases 
calculator memories. During the process: 

1. You are asked to initialize the file system. 
Answering YYYY for yes erases all file titles from 
the file menu.  

2. Next you are asked to initialize the optional 
Flash system. Pressing YYYY for yes erases all Flash 
files.  

3. Then you are asked to initialize the folder 
system. Doing so without initializing the file or 
Flash systems should allow you to later repair 
your folders without losing files.  
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4. Finally you are asked to delete all data in the 
file area. Answering YYYY for yes permanently 
deletes all files. 

To perform a cold reset without losing files: 

1. Hold down ALT+CTRL+WINDOWS KEY ALT+CTRL+WINDOWS KEY ALT+CTRL+WINDOWS KEY ALT+CTRL+WINDOWS KEY during 
system power on. 

2. Press NNNN for no when promted to initialize the file 
system. 

3. Press NNNN for no when promted to initialize the 
flash system. 

4. Press YYYY for yes when prompted to initialize the 
folder system. 

5. Press NNNN for no when asked to delete all file 
information in the file area. 

6. Recreate your folders using the same names as 
were previously used. 

Hardware ResetHardware ResetHardware ResetHardware Reset    
There is a hardware reset button on the back of the 
Type Lite just left of the parallel port. This button is 
very small and recessed. Use a straightened paper 
clip or a stylus to press this button. 

Using the hardware reset button does not delete your 
files, and may not even reset configuration settings 
to defaults. This button should be used only if the 
other reset options do not respond. If your Type Lite 
is functioning normally and you press this button, 
there may be no response at all. 
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Updating the FirmwareUpdating the FirmwareUpdating the FirmwareUpdating the Firmware    
The Type Lite uses a software updatable firmware 
that allows you to quickly update and ensure you 
have all the latest features and functionality. You do 
not need to service your Type Lite to update the 
firmware. Just back up all of your files, load the 
firmware update into your Type Lite, and run it. 

Getting StartedGetting StartedGetting StartedGetting Started    
Before the update process is started, all files on the 
Type Lite need to be backed up to disk or to your 
computer, and the file TLENG.BNS must be copied to 
the Type Lite. The update process deletes all files on 
the Type Lite, so any files not backed up are lost. 
TLENG.BNS is a large file so if you have lots of files in 
RAM, you may need to move them to Flash. 

The update process updates the system software in 
the Type Lite. If this process is interrupted, 
permanent damage may result. If your battery is low, 
we recommend first charging it, or running the 
update while using the AC adapter. 

Using the Disk DriveUsing the Disk DriveUsing the Disk DriveUsing the Disk Drive    

If you plan to use the external disk drive available 
from Freedom Scientific, follow these steps. 

1. Connect the disk drive to the disk drive port, 
which is directly to the right of the Compact 
Flash slot on the back of the Type Lite. 

2. Power on the Type Lite and the disk drive. 
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3. Insert a blank disk into the disk drive. 

4. Press SHIFT+F8 SHIFT+F8 SHIFT+F8 SHIFT+F8 to open the Disk Drive menu. 

5. Press YYYY for Y-modem Transfer. 

6. Press SSSS to send. 

At this point, you have several options: 

• Press SPACEBAR SPACEBAR SPACEBAR SPACEBAR to mark the selected file. Arrow 
through the list to select all files you wish to 
back up. 

• Press RRRR to mark all RAM files. 

• Press FFFF to mark all Flash files. 

Press ENTERENTERENTERENTER when complete, and the transfer begins. 

To copy the update file, TLENG.BNS, to the Type Lite: 

1. Insert the disk containing the update file into 
the external disk drive. 

2. Press SHIFT+F8SHIFT+F8SHIFT+F8SHIFT+F8 to open the Disk Drive menu. 

3. Press YYYY for Y-modem transfers. 

4. Press RRRR to receive. 

5. Type in the file name, TLENG.BNS. 

6. Press ENTERENTERENTERENTER to start the transfer. 

At this point you are ready to run the update. 

Using WinUsing WinUsing WinUsing WinDiskDiskDiskDisk    

 If you plan to use WinDisk to back up the Type Lite 
and copy over the update file, follow these steps. 
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NoteNoteNoteNote: If you have already used WinDisk to create 
a back up set, move, rename, or delete this 
back up set before proceeding. 

1. Connect the Type Lite to your computer via the 
serial port provided with the unit. 

2. Power on the Type Lite and press F9F9F9F9, ALT+WALT+WALT+WALT+W to 
enter WinDisk mode. 

3. Open Windows Explorer or My Computer and 
navigate to and open the Blazie Engineering 
note-taker entry. 

4. Press CTRL+BCTRL+BCTRL+BCTRL+B to back up all Type Lite files. 

The status of the back up process is displayed on the 
Type Lite.  

When the backup process is complete, you are ready 
to copy the update file to the Type Lite. 

1. Navigate to the folder or disk in which 
TLENG.BNS is located. 

2. Navigate to the file and press CTRL+CCTRL+CCTRL+CCTRL+C to copy 
the file. 

3. Navigate to the Blazie Engineering note-taker 
entry, locate the RAM Startup folder and open it. 

4. Press CTRL+VCTRL+VCTRL+VCTRL+V to paste the file. It may take a few 
moments for the file to transfer to the Type Lite. 

5. Exit Windows Explorer or My Computer, then 
press ESCESCESCESC on the Type Lite to exit WinDisk Mode. 

At this point you are ready to run the update. 
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Starting the UpdateStarting the UpdateStarting the UpdateStarting the Update    
You should now be ready to run the update on the 
Type Lite. 

1. Press F9F9F9F9, XXXX to start the update. 

2. A prompt warns that updating your unit may 
destroy your files, and then asks if you are sure 
you want to continue. Enter YYYY to proceed.  

3. There is a second verification prompt. Press YYYY 
again to proceed. 

The Type Lite takes a few moments to verify the 
program is valid. If speech was off, it is turned on. A 
series of beeps indicates the process continues.  

The Type Lite may prompt that it has detected "super 
flash memory," and ask you to select bank A or B. 
This indicates your Type Lite has two language banks. 
Even if you have an English only version, both 
language banks must be updated. Bank B must be 
updated first, so select B the first time you run the 
update. After successfully running the update, run it 
again and select bank A. 

When the validation process is finished, several 
messages are displayed/spoken, warning you not to 
do anything until the process is complete. The Type 
Lite also indicates to turn off your unit when you 
receive a continuous high pitch tone. Finally, it tells 
you that if you hear rapid beeping for more than 
thirty seconds, your update has failed.  
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After the messages are finished, the Type Lite beeps 
again as it did in the validation process. This will 
continue for two to three minutes, then your unit will 
abruptly sound a continuous, high pitch tone. When 
this occurs, turn off your unit.  

NoteNoteNoteNote: If the Type Lite rapidly beeps for some 
time, the update process has failed. Contact 
Freedom Scientific hardware technical 
support for assistance. It is very rare for 
this to occur. 

After turning the Type Lite back on, it may not speak. 
It also may speak gibberish or the voice may sound 
very strange or garbled. If this happens, first try a 
warm reset at power on. To do this, press and hold 
down ALTALTALTALT+CTRL+DELETE+CTRL+DELETE+CTRL+DELETE+CTRL+DELETE as you power on the Type 
Lite. 

At this point, the Type Lite should be functioning 
properly. If you were asked to select a language bank 
during the update process, rerun the TLENG.BNS 
program and select bank A when prompted. Once 
complete, the TLENG.BNS file is no longer needed. As 
this file is quite large, you may wish to delete it. 

If your Type Lite does not behave normally after 
performing the warm reset at power on, perform a 
cold reset. This clears the machine of your files, but 
it also reinitializes the Type Lite, allowing the new 
update to run properly.  

Press and hold down ALT+CTRL+WINDOWS KeyALT+CTRL+WINDOWS KeyALT+CTRL+WINDOWS KeyALT+CTRL+WINDOWS Key 
during power on to perform a cold reset. This step is 
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not necessary if your system functions properly after 
the warm reset described above. 

During a cold reset, parts of the file and folder 
system are reinitialized. Answer YYYY for yes to each 
question asked during this process. 

After your system is fully updated, the onboard help 
indicates it is the "mini help file." The diskette on 
which you received the firmware update should 
contain a file, TLENG.HLP. Copy this file to the Type 
Lite and rename it to "help." Use the process listed 
above to copy the file, substituting the appropriate 
file name. To rename the TLENG.HLP file once it is on 
the Type Lite, press F1F1F1F1, locate the file, press ALT+RALT+RALT+RALT+R, 
and type in the new name, help. 
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Appendix AAppendix AAppendix AAppendix A    
The Type Lite KeyboardThe Type Lite KeyboardThe Type Lite KeyboardThe Type Lite Keyboard    

This appendix documents the layout of the Type Light 
keyboard. The Type Lite uses a standard Windows 
QWERTY style keyboard. This section does not 
discuss the standard alpha-numeric keys, but covers 
the surrounding keys, which are layed out as follows: 

The Top RowThe Top RowThe Top RowThe Top Row    
Starting from the left, the top row of the Type Lite 
keyboard consists of: 

• Escape 

• Function Keys F1 through F12 

• Numlock 

• Insert 

• Delete 

• Break 

The Left SideThe Left SideThe Left SideThe Left Side    
Below the Escape key, and continuing down the left 
side of the keyboard you will find: 

• Grave 

• Tab 

• Caps Lock 

• Shift 
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• Fn 

The Right SideThe Right SideThe Right SideThe Right Side    
Below the Break key, and continuing down the right 
side of the keyboard you will find: 

• Backspace 

• Back Slash 

• Enter 

• Up Arrow 

• Down Arrow (directly below Up Arrow) 

• Right Arrow (directly to the right of Down Arrow) 

Additionally, Left Arrow is directly to the left of Down 
Arrow. 

The Bottom RowThe Bottom RowThe Bottom RowThe Bottom Row    
From left to right, the bottom row consists of: 

• Fn 

• Control 

• Windows Key 

• Alt 

• Spacebar 

• Alt 

• Windows Key 

• Applications 

• Control 

• Left Arrow 
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• Down Arrow 

• Right Arrow 

Additional KeysAdditional KeysAdditional KeysAdditional Keys    
When pressed together with the FN key, several keys have 
alternate functions. 

FN+LEFT ARROW HOME 

FN+RIGHT ARROW END 

FN+UP ARROW PAGE UP 

FN+DOWN ARROW PAGE DOWN 

FN+INSERT PRINT SCREEN 
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Appendix BAppendix BAppendix BAppendix B    
Type Lite Ports and SwitchesType Lite Ports and SwitchesType Lite Ports and SwitchesType Lite Ports and Switches    

This appendix documents the ports and switches on 
the Type Lite. The ports and switches are labeled in 
braille on the underside of the casing. 

On/OffOn/OffOn/OffOn/Off    

The On/Off switch is on the right side of the Type 
Lite. Toggle the switch towards the back of the 
system to turn on the Type Lite, and toggle the 
switch towards the front of the system to turn off the 
Type Lite. These switch positions are labeled in 
braille as "on" and "off." 

HeadphoneHeadphoneHeadphoneHeadphone    

The headphone jack is on the right side of the system 
between the On/Off switch and the back of the 
system. It is labeled in Braille as “ear.” 

Braille DisplayBraille DisplayBraille DisplayBraille Display    

The Braille Display switch is on the left side of the 
TYPELite. Toggle the switch towards the back of the 
system to turn on Note Taker mode. Toggle the 
switch towards the front of the system to turn on 
Braille Display mode. The switch positions are 
labeled in braille as "A" and "B."  

AC AdapteAC AdapteAC AdapteAC Adapter Jackr Jackr Jackr Jack    
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The AC adapter jack is on the back of the system 
towards the left side. This jack is labeled in braille as 
"AC." 

Compact FlashCompact FlashCompact FlashCompact Flash    

The compact flash™ module is immediately to the 
right of the AC adapter jack, and is labeled in braille 
as "CF." 

 Disk Drive Port Disk Drive Port Disk Drive Port Disk Drive Port    

The disk drive port is immediately to the right of the 
compact flash module, and is labeled in braille as 
"dd." 

Serial Port JaSerial Port JaSerial Port JaSerial Port Jackckckck    

The serial port jack is immediately to the right of the 
disk drive port, and is labeled in braile as "ser." 

Keyboard PortsKeyboard PortsKeyboard PortsKeyboard Ports    

The next two ports, labelled in Braille as "pc" and 
"kbb," are not implemented at this time. 

Hardware ResetHardware ResetHardware ResetHardware Reset    

Between the keyboard ports and the printer port is 
the hardware reset button. The hardware reset 
button is a very small recessed button. Use a 
straightened paper clip or a toothpick to press this 
button. This button should only be used as a last 
resort. 

Printer Printer Printer Printer PortPortPortPort    
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At the right end of the back of the Type Lite is a 
standard parallel port. Use this port to connect to a 
printer or embosser. 
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Appendix CAppendix CAppendix CAppendix C    
The File MenuThe File MenuThe File MenuThe File Menu    

This appendix documents the commands available in 
the File menu. These commands are organized by 
function. All commands must be entered after first 
opening the File menu (F1F1F1F1). 

NavigationNavigationNavigationNavigation    
Enter File Menu F1F1F1F1 

Exit File Menu ESCESCESCESC 

File Commands Menu BREAK BREAK BREAK BREAK  

Forward through 
File List DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW 

Back through 
File List UP ARROWUP ARROWUP ARROWUP ARROW 

Forward through File List  
(File Names Only) RIGHT ARROWRIGHT ARROWRIGHT ARROWRIGHT ARROW 

Backward through File List  
(File Names Only) LEFT ARROWLEFT ARROWLEFT ARROWLEFT ARROW 

Top of File List FN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROWFN+LEFT ARROW 

End of File List FN+RIGHT ARROWFN+RIGHT ARROWFN+RIGHT ARROWFN+RIGHT ARROW 

GeneralGeneralGeneralGeneral    
Create File CCCC    
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Open File OOOO 

Open Selected File ENTERENTERENTERENTER 

Delete File DDDD 

Delete Selected File DELETEDELETEDELETEDELETE 

Global Delete GGGG 

Rename Open File SHIFT+F3 SHIFT+F3 SHIFT+F3 SHIFT+F3 or RRRR 

Rename Selected File F3F3F3F3 or ALT+RALT+RALT+RALT+R 

Protect Open File SHIFT+F5 SHIFT+F5 SHIFT+F5 SHIFT+F5 or PPPP 

Protect Selected File F5F5F5F5 or ALT+PALT+PALT+PALT+P 

Unprotect Open File SHIFT+F4 SHIFT+F4 SHIFT+F4 SHIFT+F4 or UUUU 

Unprotect Selected File F4 F4 F4 F4 or ALT+UALT+UALT+UALT+U 

Password Protect File WWWW  

NoteNoteNoteNote: You are prompted to type a 1 to 6 character 
password twice. Press ENTER ENTER ENTER ENTER after typing 
the password. To remove the password of 
the open file, press ENTERENTERENTERENTER twice. 

Recover Open File EQUAL SIGNEQUAL SIGNEQUAL SIGNEQUAL SIGN 

NoteNoteNoteNote: This command may be useful after a crash 
or a Cold reset when the file system has 
been initialized. 

Search for Files ALT+FALT+FALT+FALT+F 

Note: When searching for files, you are prompted 
for a file name or partial file name with 
wild cards - such as *.txt or *.brl. Use UP 
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ARROW and DOWN ARROW to move 
through the results list, ENTER to select a 
file, or ESC to exit the list. 

InformationInformationInformationInformation    
Free Memory in Pages FFFF 

Verbose File List VVVV 

Copy File List 
to Clipboard ALT+VALT+VALT+VALT+V 

List Names of All Files LLLL 

Quick File List QQQQ 

Tell Name of Open File TTTT 

Tell Name of 
Selected File CTRL+UP ARROW 

Spell Name of 
Selected File CTRL+DOWN CTRL+DOWN CTRL+DOWN CTRL+DOWN 
ARROWARROWARROWARROW 

Information on File(s) SHIFT+F8 SHIFT+F8 SHIFT+F8 SHIFT+F8 or IIII 

Information on 
Selected File F8F8F8F8 or INSERTINSERTINSERTINSERT 

Time/Date 
Information on File(s) SHIFT+F6 or MMMM 

Time/Date Information on 
Selected File F6 F6 F6 F6 or ALT+MALT+MALT+MALT+M 

Tell Size of File(s) SHIFT+F7 SHIFT+F7 SHIFT+F7 SHIFT+F7 or 
COLONCOLONCOLONCOLON 
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Tell Size of 
Selected File F7F7F7F7 or ALT+COLONALT+COLONALT+COLONALT+COLON 

OtheOtheOtheOtherrrr    
The following commands are still available, but 
should not be necessary. The Type Lite automatically 
resizes files as needed.  

Make Open 
File Bigger SHIFT+F2 SHIFT+F2 SHIFT+F2 SHIFT+F2 or BBBB 

Make Selected 
File Bigger F2F2F2F2 or ALT+BALT+BALT+BALT+B 

Make Open 
File Smaller SHIFT+F1 SHIFT+F1 SHIFT+F1 SHIFT+F1 or SSSS 

Make Selected 
File Smaller F1F1F1F1 or ALT+SALT+SALT+SALT+S 

File TransfersFile TransfersFile TransfersFile Transfers    
Transfer Protocols ALT+TALT+TALT+TALT+T 

Selected File to Serial 
Port with Y-modem F10F10F10F10 

File from Serial Port  
with Y-modem NUMLOCKNUMLOCKNUMLOCKNUMLOCK 

External ProgramsExternal ProgramsExternal ProgramsExternal Programs    
Run Selected  
External Program FFFF9999 or ALT+XALT+XALT+XALT+X 
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Run Selected 
External Program 
with Arguments XXXX 

Information on Selected 
External Program QUESTION MARKQUESTION MARKQUESTION MARKQUESTION MARK 

Move to Previous 
External Program CTRL+LEFT ARROWCTRL+LEFT ARROWCTRL+LEFT ARROWCTRL+LEFT ARROW 

Move to Next 
External Program CTRL+RIGHT CTRL+RIGHT CTRL+RIGHT CTRL+RIGHT 
ARROWARROWARROWARROW 

Toggle between 
Quick Load 

and Normal Load ALT+ALT+ALT+ALT+SLASHSLASHSLASHSLASH    

NoteNoteNoteNote: The program must be in RAM. 

FoldersFoldersFoldersFolders    
Except where noted, Allow Folder Mode must be on 
in the status menu (F10F10F10F10, ALT+F ALT+F ALT+F ALT+F, YYYY) and Folder Mode 
must be on in the File menu. Press SPACEBARSPACEBARSPACEBARSPACEBAR while 
in the File menu to toggle between All Files Mode 
and Folder Mode. The default folders are ramstartup 
(0) and Flash Startup (1). There cannot be more than 
twenty folders. 

Create Folder PLUSPLUSPLUSPLUS    

Forward through Folders FN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROW 

Back through Folders FN+UP ARROWFN+UP ARROWFN+UP ARROWFN+UP ARROW 

Top of Folder List ALT+8ALT+8ALT+8ALT+8 
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End of Folder List ALT+0ALT+0ALT+0ALT+0 

Delete Empty Folder DASHDASHDASHDASH    

Rename Active Folder ALT+SHIFT+8ALT+SHIFT+8ALT+SHIFT+8ALT+SHIFT+8 

Quick Folder Opening 
by Number 0000 through 9999 

Name of Open Folder ALT+7ALT+7ALT+7ALT+7 

Move Selected File SHIFT+NUMLOCKSHIFT+NUMLOCKSHIFT+NUMLOCKSHIFT+NUMLOCK 

NoteNoteNoteNote: A list of folders is displayed. Use UP UP UP UP 
ARROARROARROARROW W W W and DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW to move 
through the list, and press ENTERENTERENTERENTER to select 
a folder. The folder number (0 through 9) 
may also be typed. 

Move Selected File when 
in All Files Mode SHIFT+NUMLOCKSHIFT+NUMLOCKSHIFT+NUMLOCKSHIFT+NUMLOCK 

NoteNoteNoteNote: You are asked to move the selected file into 
Flash if it is in Ram, or into Ram if it is in 
Flash. 

Move File(s) SHIFT+COMMA SHIFT+COMMA SHIFT+COMMA SHIFT+COMMA  

NoteNoteNoteNote: This command lists files in the current 
folder. Mark files with YYYY or SPACEBARSPACEBARSPACEBARSPACEBAR. 
Switch between folders with FN+UP ARROWFN+UP ARROWFN+UP ARROWFN+UP ARROW 
or FN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROW. Press ENTERENTERENTERENTER when 
all desired files are marked. Then move to 
the destination folder with UP ARROWUP ARROWUP ARROWUP ARROW or 
DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW, and press ENTER.ENTER.ENTER.ENTER. 
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Appendix DAppendix DAppendix DAppendix D    
The Option Menu The Option Menu The Option Menu The Option Menu     

This appendix documents the items available in the 
Option menu, and the access keys for each item. The 
first three items do not appear in the Option menu, 
but relate to it or are available from it. 

Open Option Menu F9 F9 F9 F9 or ALT+OALT+OALT+OALT+O 

Quick File Opening 
by Number 00 00 00 00 to 99 99 99 99 

Spell Check SHIFT+8SHIFT+8SHIFT+8SHIFT+8 

Check Appointments AAAA 

Braille Display BBBB 

Calculator CCCC 

Date DDDD 

Open Datebook File DELETEDELETEDELETEDELETE or ALT+DALT+DALT+DALT+D 

Datebook Entry EEEE 

File Commands FFFF 

Smart Calendar GGGG    

Calculate Line KKKK 

Open the 
Previously Opened 
File LLLL 
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Open Currently 
Selected File OOOO 

Open Phone Book ALT+PALT+PALT+PALT+P 

Phone Book (Entry) PPPP 

Review Mode RRRR 

NoteNoteNoteNote: Review Mode is a read only mode for 
proofreading documents. 

Set Time SSSS, TTTT 

Set Date SSSS, DDDD 

American Time SSSS, 1111 

European Time SSSS, 2222 

Time TTTT 

Upper Case 
Proof Mode UUUU  

Speech VVVV 

Toggle 2D Mode ALT+VALT+VALT+VALT+V 

NoteNoteNoteNote: 2D Mode is used to show the layout of a 
document. 

Stopwatch WWWW 

WinDisk ALT+WALT+WALT+WALT+W 

Execute Program XXXX 

Serial Number ALT+SHIFT+SLASHALT+SHIFT+SLASHALT+SHIFT+SLASHALT+SHIFT+SLASH    
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Appendix EAppendix EAppendix EAppendix E    
The Status MenuThe Status MenuThe Status MenuThe Status Menu    

The following options are available in the Status 
Menu.  

NavigationNavigationNavigationNavigation    
Open Status Menu F10F10F10F10 or ALT+SLASHALT+SLASHALT+SLASHALT+SLASH    

Exit ESCESCESCESC 

Next Item DOWN ARROWDOWN ARROWDOWN ARROWDOWN ARROW    

Prior Item UP ARROWUP ARROWUP ARROWUP ARROW 

Next Section FN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROWFN+DOWN ARROW 

Prior Section FN+Up ARROWFN+Up ARROWFN+Up ARROWFN+Up ARROW 

Access Key ALT+DOWN ALT+DOWN ALT+DOWN ALT+DOWN 
ARROWARROWARROWARROW 

Toggle Setting SPACEBARSPACEBARSPACEBARSPACEBAR    

Items that are either on or off can also be set by 
Pressing YYYY for On or NNNN for Off. If there are other 
commands to toggle settings, they are listed below 
the relevant item. 

Serial ParametersSerial ParametersSerial ParametersSerial Parameters    
Serial Port FFFF 

BAUD Rate BBBB    
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    To Set:To Set:To Set:To Set:    Type:Type:Type:Type:    

 300 30303030 

 600 6666 

 1200 12121212 

 2400 2222 

 4800 4444 

 9600 9999 

 19200 19191919 

 38400 38383838 

 115200 11111111 

 

Parity PPPP    

    

 To Set:To Set:To Set:To Set: Type:Type:Type:Type: 

 Odd OOOO 

 Even EEEE 

 None NNNN 

 

Duplex DDDD 

    

 To Set:To Set:To Set:To Set: Type:Type:Type:Type: 
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 Half HHHH 

 Full FFFF 

 None NNNN 

 

Data Bits ____ (SHIFT+DASHSHIFT+DASHSHIFT+DASHSHIFT+DASH) 

    

 To Set:To Set:To Set:To Set: Type:Type:Type:Type:    

 7 7777 

 8 8888 

 

Stop Bits SSSS 

    

 To Set:To Set:To Set:To Set: Type:Type:Type:Type:    

 1 1111 

 2 2222 

 

Handshaking HHHH    

    

 To Set:To Set:To Set:To Set: Type:Type:Type:Type: 

 Software SSSS 

 Hardware HHHH 
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 None NNNN 

 

Interactive GGGG    

Interactive Time Out XXXX    

Specify a number from 0 to 255 and press ENTERENTERENTERENTER. 

Add Linefeed 
when Transmitting AAAA 

Reject Ornamentation 
Characters OOOO 

Speech ParametersSpeech ParametersSpeech ParametersSpeech Parameters    
Speech ALT+SALT+SALT+SALT+S 

Speak Words in 
Say All Mode SHIFT+0SHIFT+0SHIFT+0SHIFT+0 

Ham Calls MMMM 

NoteNoteNoteNote: This item is used to speak letter-number 
combinations such as w1aw. 

Braille Display ParametersBraille Display ParametersBraille Display ParametersBraille Display Parameters    
Braille Display ALTALTALTALT+B+B+B+B 

Serial Tracking ALT+TALT+TALT+TALT+T 

Keyboard Tracking ALT+KALT+KALT+KALT+K 

Reverse Advance ALT+DALT+DALT+DALT+D 

8 Dot Mode ALT+8ALT+8ALT+8ALT+8 
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Control Chars ALT+XALT+XALT+XALT+X 

Cursor Always Visible ALT+VALT+VALT+VALT+V 

Word Wrap ALT+WALT+WALT+WALT+W 

End Display on 
Carriage Return ALT+RALT+RALT+RALT+R 

Display All ALT+=ALT+=ALT+=ALT+= 

Grade 2 Messages ALT+GALT+GALT+GALT+G 

View in Grade 2 ALT+7ALT+7ALT+7ALT+7 

EditEditEditEditor Parametersor Parametersor Parametersor Parameters    
Braille Translator TTTT 

Cursor Tracking CCCC 

Column Beeper QQQQ    

Specify a number between 0 and 255 and press 
ENTERENTERENTERENTER. 

Speak Windows Lines 

or Sentences VVVV    

    

    To Set:To Set:To Set:To Set:    Type:Type:Type:Type:    

 Windows WWWW 

 Lines LLLL 

 Sentences SSSS 
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Window Length WWWW    

Specify a number between 18 and 255 and press 
ENTERENTERENTERENTER. 

PC Editing Mode DOLLAR SIGNDOLLAR SIGNDOLLAR SIGNDOLLAR SIGN    

Specify YYYY for On, NNNN for Off, or IIII for On with Insert at 
Startup. 

Skip Blank Lines SHIFT+7SHIFT+7SHIFT+7SHIFT+7 

Distinguish Case During Find SHIFT+1SHIFT+1SHIFT+1SHIFT+1 

Progress Clicks KKKK 

Say ASCII Values CTRL+DOWN CTRL+DOWN CTRL+DOWN CTRL+DOWN 
ARROWARROWARROWARROW 

Format ParametersFormat ParametersFormat ParametersFormat Parameters    
Printer Compatibility LLLL    

    

    To Set:To Set:To Set:To Set:    Type:Type:Type:Type:    

 Epson EEEE 

 HP HHHH 

 Image Writer IIII 

 

Number Pages SHIFT+3SHIFT+3SHIFT+3SHIFT+3 

Put Page Number 
on First Page No Access KeyNo Access KeyNo Access KeyNo Access Key 

Double Space SHIFT+PERIODSHIFT+PERIODSHIFT+PERIODSHIFT+PERIOD 
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The following page format parameters control the 
margins on a print or braille  

page. There are no access keys for these items. The 
default settings are listed instead. 

Print Line Length 75757575 

Print Left Margin 10101010 

Print Page Length 60606060 

Print Top Margin 6666 

Braille Line Length 33333333 

Braille Left Margin 1111 

Braille Page Length 25252525 

Braille Top Margin 1111 

System ParametersSystem ParametersSystem ParametersSystem Parameters    
Revision Date RRRR 

Battery Timer QUESTION MARKQUESTION MARKQUESTION MARKQUESTION MARK    

Press SPACEBAR SPACEBAR SPACEBAR SPACEBAR to reset the battery timer. 

Check Appointments JJJJ 

Hourly  
Announcement ALT+H ALT+H ALT+H ALT+H  

 

    To Set:To Set:To Set:To Set:    Type:Type:Type:Type:    
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 Bell 1111 

 Voice 2222 

 Bell and Voice 3333 

 Off NNNN 

 

Power Reminder ZZZZ 

Allow Folder Mode ALT+FALT+FALT+FALT+F 
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IIIIIIIInnnnnnnnddddddddeeeeeeeexxxxxxxx        
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2222 
2D Mode 107 

AAAA 
AC Adapter 84 
access key 5, 29, 37, 39 
Advance Bars 24 
Append Mode 26 
Appointment Notification

 50 

BBBB 
Battery 84, 114 
Braille 2, 3, 12, 18, 22, 

24, 25, 35, 36, 67, 73, 
74, 75, 77, 82, 97, 98, 
106, 111, 114 

Braille Display 3, 76, 97 
Advance Bars 24 
Cursor Routing Buttons

 24 
Parameters  29, 65, 

108, 111 
Reverse Advance 24, 

111 
Rocker Buttons 25 

Browse Mode 49 

CCCC 
Calculator 54, 56, 57, 58, 

59, 106 
Conversions 58 
Decimal Precision 56 
Embedded Keypad 56 
Memory Locations 59 
Scientific Functions 57 

Check AppointmentsCheck AppointmentsCheck AppointmentsCheck Appointments 48, 
106, 114 

Classic View 115 
Clipboard 28, 30, 35, 102 

Commands 
File Menu 100  
Folders 40, 41, 104 
Formatting 65, 67, 69, 

74, 75 
Move 22  
Option Menu 106 
Print 23, 114 
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